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What’s New in Microsoft Office 2013? 
 
This course covers 8 hours of the very best and most essential Office 2013 functionality that CPAs 
should be using in the performance of their jobs. This course is best suited for moderate level 
office users who know how to use the basic functionality of Office, but have seldom explored the 
more powerful features and capabilities that Office has to offer, including the following new 
features found in office 2013.  
 

 
 

1. No Changes to the 2013 Ribbons - Many CPAs worry that Office’s new touch-

screen functionality means the product’s new ribbons that will be time-consuming to 

learn, but this is not the case. Office 2013’s ribbons work and look almost exactly like 

Office 2010’s ribbons, and transitioning to the new product involves only a minor learning 

curve. While the new touch-screen controls provide new ways to launch and use the 

applications on touch-screen devices, the 2010-style ribbon along with a standard 

keyboard and mouse remains to be the primary means for operating the product.  

 

2. Touch-Enabled - On mobile devices, the ribbons offer the same menu options, but 

they are redesigned to better fit smaller hand-held devices. Most of Office’s new touch 

controls work similar to mouse-clicks, but new gestures have been added. For example, 

you can navigate Excel workbooks or multiple pages in Word by swiping your finger across 

the screen. You can also pinch and spread to shrink or enlarge your spreadsheets, 

documents or presentations. A new Touch Mode button inserts more space around the 

Ribbon’s icons so operating the touch controls on smaller devices is a little easier.  

 

 

New Global Features in Office 2013 
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3. Windows 8 Style Tiles - Office’s new square, color-coded tiles (see figure) are used 

to launch applications on your tablet, smartphone, or computers equipped with touch-

screen monitors. The tiles can be resized and rearranged to your preference, and the 

color-coded schemes make it easier to identify and select the correct application. Office’s 

tiles match the Windows 8 tiles which have been praised by some for their simplicity and 

utility. 

 

  
Examples of Office 2013 Quick Launch Tiles in Windows 8 

 

4. Quick Demonstration of Excel 2013 on a Touchscreen Mobile 

Device-  

 

5. Cloud Enabled - Office binds you to the cloud in many ways. For example, Office 

automatically connects to your free cloud-based SkyDrive which includes 20 GBs of data 

storage space, email account, contact management, calendar management, and the 

following free web apps: 2013 editions of Word, Excel, PowerPoint, and OneNote. These 

web apps are cloud-based versions of the popular applications (with limited commands 

and features), accessible from any web browser on a desktop, laptop, tablet or 

smartphone device.  
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Office 2013's Free Web Apps 

 
a) See SkyDrive on the smartphone. 

b) See example of opening the same Excel file from SkyDrive on Desktop 

computer. 

c) File, Info – Pick the sheets that browsers can see when opening that file. 

d) Save a file to SkyDrive, show options to invite people, get a link, Post to 

Facebook or email. 

 

6. Web Apps - Since everyone has access to the free web apps, troublesome file-sharing 

barriers and file compatibility issues are removed; therefore, CPAs can use Office 2013 

with the confidence of knowing that documents and workbooks they produce can be 

easily viewed and edited by others.  

7. Microsoft Office 365 - Office 365 is a new subscription plan for purchasing Office 

via a monthly rental agreement. Subscription Pricing – Enables you to install Excel on five 
devices, and run Excel from the cloud. 

 
a) Pay month-to-month instead of all at once 
b) Installs on more PCs  
c) Never upgrade again 
d) Superior iMap email  
e) Better security  
f) File Sharing  
g) Eliminate upfront capital costs  
h) Eliminate balance sheet liabilities 

 

Subscription Rental Plan - Microsoft offers Office via a subscription plan and 

many CPAs are finding the rental plan to be a better option than purchasing the product. 
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Pricing options and functionality for selected Office 2013 editions are summarized in the 

table below. 

 

 
Office Edition 

 
Users/PCs Price Included 

 
Purchase Options: 

Office Home & 
Business 

1 user/3 
PCs 

$279.99 Word, Excel, PowerPoint, 
OneNote, Outlook 

Office Professional 1 user/2 
PCs 

$499.99 Word, Excel, PowerPoint, 
OneNote, Outlook, Access, 

Publisher 

 
Subscription Options: 

Office 365 Professional 
Plus 

1 user/5 
PCs 

$15/Month Word, Excel, PowerPoint, 
OneNote, Outlook, Access, 

Publisher 

Office 365 E3 Plan 1 user/5 
PCs 

$20/Month Word, Excel, PowerPoint, 
OneNote, Outlook, Access, 

Publisher, Cloud-based email, 
Web conferencing, Shared 

calendars, Cloud-based team 
sites, Office Web Apps 

Pricing Options for Selected Editions of Office 2013 

 
Seven advantages for renting rather than purchasing are as follows: 
 
1. Installs on more PCs - The subscription plan allows you to install Office professional 

on five computers or devices, compared to just two or three installations with the 
purchased product.  
  

2. Never upgrade again – Renters will never face an upgrade decision again as future 
product enhancements are included automatically.  

 
3. Superior iMap email - The subscription plan includes a cloud-based email solution 

using iMap (Internet Message Access Protocol), which is stronger than the traditional 
Pop3 (Post Office Protocol) email solution. This is because iMap maintains email 
messages, replies, contacts, tasks and calendars in a central location so you can access 
them from any of your computers, the web, or mobile devices. In contrast, Pop3 
maintains this information on the individual computers, thus accessing this 
information from multiple computers or devices is more problematic. 
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4. Better security - In the cloud, data is securely encrypted from your computer to the 
cloud, and your data remains encrypted in the cloud. Your data is also backed up 
automatically on a continuous basis and is protected by world-class firewalls, anti-
virus software, and intrusion monitoring solutions. A significant amount of 
technology, cost and effort is needed to duplicate this level of security on a local 
computer or file server. 

 
Exception – Warning!!! 

 Microsoft’s agreement allows them to read your files!!! 
 
Here’s the code of conduct agreement:  
http://windows.microsoft.com/en-us/windows-live/code-of-conduct 
 
Here’s an example article in Forbes:  
http://www.forbes.com/sites/kellyclay/2012/07/19/is-microsoft-spying-on-skydrive-
users/  

 
5. File Sharing – The subscription plan includes a cloud-based SkyDrive (starting at 20 

GBs), team management tools, and file syncing options to help groups work in 
collaboration. You can grant permission to others to access your SkyDrive files or 
folders, even if they don’t use Office. In the cloud environment, email attachments 
are unnecessary because you can send recipients a link instead of attachments; as a 
result, emails travel faster, deliveries are no longer hung up due to attached file size 
restrictions, and attachments no longer contribute to oversized inbox data files.  
 

6. Eliminate upfront capital costs – For larger companies, the subscription plan 
eliminates their need to borrow money to purchase product. By opting for the “pay 
as go” subscription plan, companies can expense the costs as a monthly operating 
expense;  

 
7. Eliminate balance sheet liabilities – For larger companies, FASB 47 requires disclosure 

of long term obligations, but because Office’s subscription plan requires no long-term 
commitment, these rental obligations need not be included on the balance sheet. 

 
The Office 365 Account Management Screen 
 
To access your Office 365 account settings, in any Office 365 product, select File, Account and 
click the Manage Account button, as pictured below. 
 

http://www.carltoncollins.com/
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(Or if installing Office 365 on a new computer, type http://office.microsoft.com/myaccount and 
log in using your Office 365 user name and password.) 
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The account management screen appears as follows. 
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Notice that this screen provides a list of computers where your five Office 365 licenses have been 
installed, and you can deactivate any of these licenses at any time simply by selecting the 
deactivate button.  
 
Also on this screen above, notice the Install button which enables you to install Windows of Mac 
office 2013 on another computer. 
 

 
 

There is also an option for using Office apps on up to 5 selected devices, including an iPhone.  
 

 
 
You can try Office 365 free at  
http://office.microsoft.com/en-us/templates/redir/XT103927624.aspx  
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New in Excel 2013 
 
1. Quick Tour of Menus – Almost identical to Excel 2010 
2. Touch-Screen Enabled – Makes Excel accessible on touch-screen mobile devices. 
3. Windows 8 Style Tiles – Match Windows 8 tiles, easier to touch on a smaller mobile device. 
4. Cloud-Enabled – Save Excel workbooks directly to your free cloud data storage SkyDrive. 

a. SkyDrive (20 to 25 GBs) 
b. Get A Link – Send Excel workbooks links instead of workbooks via email. 
c. Publish Excel Data to Social Media – Embed Workbooks directly in Facebook. 

5. Office 2013 Web Apps – a free version of Excel 2013 is available via the cloud. 
6. Subscription Pricing – Enables you to install Excel on five devices, and run Excel from the cloud. 

i) Installs on more PCs  
j) Never upgrade again 
k) Superior iMap email  
l) Better security  
m) File Sharing  
n) Eliminate upfront capital costs  
o) Eliminate balance sheet liabilities 

7. Excel Instances - Excel now opens each workbook in a separate instance.  
8. Flash Fill - Watches you work and applies logic to help you complete your tasks.  
9. Timeline Slicer - Helps you slice and dice Pivot data containing dates. 
10. Recommended Pivot Tables & Charts – To help you work quicker and easier. 
11. Quick Analysis - Helps you analyze data more quickly by offering data layouts. 
12. PowerView - Enables you to create new report types, such as the interactive map charts. 
13. Create Relationships Tool – Enables you to build PivotTables from multiple data sources.  
14. More Tables – Add multiple tables to a PivotTable 
15. Drill Up and Cross Drill - Drill upward and cross drill to related tables. 
16. New PivotTable Tools - Decouple PivotCharts so they stand alone. 
17. New Chart Controls - Excel pops up new chart controls.  
18. Review Tools - New inquire Add-in reviews design, function and data dependencies. 
19. Excel Compare Tool - Similar to Word’s Compare tool. 
20. Fifty New Functions – Bring the total number of functions to 455. 
21. Office on Demand - https://office.microsoft.com/en-us/myoffice.aspx?CTT=97  
22. Managing Updates – From the File, Account menu, you can set how updates install. 

 
These concepts are described in greater depth below. 
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8. Excel Now Opens Each Workbook in a Separate Instance - Prior to Excel 2013, Excel opened multiple 

workbooks in the same instance of Excel by default. However, it was possible to launch Excel twice, 

and open workbooks in separate instances – but this approach had a problem in that Excel’s Paste 

function behaves differently when pasting between two instances of Excel compared to pasting 

between two workbooks opened in the same instance of Excel. Specifically, Excel 2010 and prior 

editions did not allow you to copy formulas back and forth between Excel files opened in separate 

instances – only the formula’s calculated value was pasted to the other instance of Excel.  

Excel 2013 now solves this problem allowing you to copy and paste formulas between 
separate instances of Excel. (FYI - Word has always opened Doc files in separate instances). 
 
This issue came to light once CPAs started using dual monitors, and they launched excel on 
each monitor only to find they could not copy and paste formulas back and forth. In case you 
have clients or colleagues that still use an older edition of Excel, here are the procedures that 
you had to follow to display two workbooks simultaneously on dual monitors, and preserve 
the ability to copy and paste formulas:  

  
1. Open only one instance of Excel. 
2. Restore down the Excel window by double-clicking the Title Bar located at the 

top of the window.  
3. Stretch the window across both monitors by hovering your mouse pointer over 

either the left or right edge of the window until your pointer becomes a double 
arrow, then click and drag the window across both monitors.  

4. Open two Excel workbooks. 
5. In Excel 2007 and 2010, select Arrange All from the View tab to display the two 

workbooks side-by-side, each appearing in a separate monitor. In Excel 2003, 
select Arrange from the Window menu, select Tiled, and click OK. 

6. You can now use Paste Special, Value, Add between the two Excel workbooks 
displayed on separate monitors.  
 
Note: To avoid undesirable results when stretching a window across two 
monitors, make sure both monitors are set to the same display resolution. 

 
9. Flash Fill - Of all the Office 2013 applications, Excel is the beneficiary of the most impressive 

enhancements. Excel’s new Flash Fill watches you work and applies logic to help you complete your 

tasks. The example pictured below (see figure below) contains a list of 44 first and last names in 

Column A, which I want to separate into Columns B and C. As I start typing the first name of the second 

record in Column B; Excel’s Flash Fill guesses what I’m trying to do and offers to fill in the remaining 

42 first names (as shown in grey text). 

  

New Features in Excel 2013 
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Excel's New Flash Fill Tool 

 
10. Timeline Slicer - Excel’s new Timeline Slicer which helps users slice and dice Pivot data that contain 

dates. As an example, selecting the dates May through October on the Timeline slicer (pictured) 

adjusts the PivotTable to display May thru October data.  

 

 
Excel's New Timeline Slicer provides a  

Visual Method of Filtering a PivotTable by Date 

 
 

Recommended PivotTables and PivotCharts - Excel offers new tools which can analyze your data 
and recommend a variety of PivotTable and Chart layouts to best illustrate the data. This new 
functionality is especially useful to novice users who are less familiar with Excel’s functionality, 
but can also help avid Excel users save time too. Simply place the cursor anywhere in your data 
area and select Recommended PivotTables (or Recommended Charts) and in return, Excel offers 
various PivotTable and Chart options and as pictured in the figure. 
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Excel's New Recommend PivotTables and Recommend Charts Tools 

 
Excel’s Quick Analysis tool also helps you analyze data by offering a variety of formatting, charts, 
totals, tables and sparkline layouts to instantly summarize large volumes of data (see figure 
below). When using Quick Analysis to scrutinize text-only data, text specific options for 
highlighting duplicate or unique text items appear. 
 

 
Example of Excel's New Quick Analysis Tool 

 
Simply place your cursor in your data area and then press Ctrl + A to highlight your data. Then 
in the bottom right corner make your selections. 
PowerView - Excel’s new PowerView inserts new worksheets connected to your data, and then 
enables you to create new report types, such as the interactive map chart presented in the figure 
below. The resulting PowerView Map report is zoomable, and filters can be applied to display 
partial data. 
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PowerView Tool Depicting a New Zoomable Map View 

 
A few points about PowerView: 
 

1. PowerView is not included in Office 2013 Professional subscription, it is available in the Office 
2013 Professional purchased product and the Office 2013 Professional Plus Subscription. 

 
2. You can try PowerView for free here, as prepared in Excel 2013 and published to SharePoint: 

http://www.microsoft.com/en-us/bi/GetMicrosoftBI/TryIt.aspx   

 
3. For demonstration purposes, I will select the Contoso Tab, Contoso Sample Data 

 
4. PowerView produces a dashboard containing multiple PowerViews, each with it’s own unique 

view and capabilities.  
 

5. For example, the Scatter Chart includes a Play button, so you can view data over time. 
 

6. By default, all PowerView reports are linked so one filter applies to all reports. Or if you prefer, 
click the Filter button in the upper right corner (as you hover a chart) to gain more control over 
filtering using the View tab versus Chart tab. 
 

7. An Advanced Filter Button, enables you to apply more advanced filters, such as “only those 
transactions greater than $1,000”. 
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8. PowerView worksheets can be published as standalone, interactive reports to Microsoft 

SharePoint’s PowerPivot Gallery or other reporting service destinations.  
 

9. You can apply themes and backgrounds, insert pictures and text boxes, insert collapsible and 
expandable tiles, and add data slicers.  
 

10. I’ll give you a quick demonstration using Excel 2013. 
 

a. Invoices 
b. Quick PowerView Map 
c. Quick PowerView Scatter Chart 
d. Play the PowerView Scatter Chart 

 
Create Relationships - As an advanced enhancement, Excel provides the new Create 
Relationships tool for building table relationships in workbooks that contain at least two tables 
sharing at least one common field name.  
 
Before you start, you first need to convert your data to Tables, using the Insert Tables tool. Then, 
with a PowerView selected, click the Create Relationships tool and fill out the resulting dialog 
box pictured below. 

  

 
Excel's New Relationship Tool for Pivoting Multiple Sources of Data 

 
Once relationships are established, the More Tables option can be used to display additional 
tables allowing you to add data fields from mutiple tables to PivotTables, as pictured. 
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Connecting Multiple Sources of Data to a PivotTable 

 

Drill Up and Cross Drill - Another PivotTable enhancement involves drillability. Previously, users 
could only drill down on PivotTable data, but now you can also Drill Up and Cross Drill to related 
tables.  
 
50 New Functions - Microsoft has added 50 new functions to Excel (increasing the total number 
of functions to 450), and the following 12 new functions in particular will appeal to many CPAs. 

 
1. ARABIC – Converts roman numerals to regular numbers, for example V, IX, and XX are converted 

to 5, 9, and 20. 
 

2. CEILING.MATH – This function can be used to round a number up to a specific interval, such as 
the nearest 99 cents, as demonstrated in figure 10. 

 

 
Example Use of Excel's New Ceiling.Math Function 

 
3. DAYS – Calculates the number of days between two dates. 

 
4. FLOOR.MATH - Rounds numbers down to a specific interval, and also can be used to round 

negative numbers towards zero, instead of towards a smaller number. For example, -8.5 can be 
rounded to -8.0 (instead of the -9.0 results delivered by the older Round function).  

 
5. FORMULATEXT – Displays referenced formulas as text, and can be used to improve formula 

reading, reviewing and printing. 
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6. ISFORMULA – Returns the value TRUE if the referenced cell contains a formula. 

 
7. ISOWEEKNUM – Calculates the week during the year in which a given date falls. As an example, I 

used this formula to determine that I was born in the 53rd week of 1959. 

 
8. PDURATION - Returns the number of periods required by an investment to reach a specified 

value. For example, you could calculate that $1,000 invested at 6% APR would take 26.89 years to 
reach a value of $5,000. (This function approach is faster than constructing a 322 row table to 
figure this out.) 

 
9. RRI – This function returns an equivalent interest rate for the growth of an investment. For 

example, you could calculate that a $1,200 mutual investment that grew to $5,600 in 18 years 
earned an average return of 8.93%. 

 
10. SHEET – Calculates the sheet number of the referenced sheet. For example, you might use this 

function to determine that your interest rate assumptions are entered on the 46th sheet in your 
workbook. 

 
11. SHEETS – Calculates the total number of sheets in a referenced range.  

 
12. SKEW.P – Like the Skew function, SKEW.P calculates the standard deviation of a string of data, 

but bases its calculation on the entire population instead of a sample of the population. This 
function could be used to determine whether each line item of a company’s historical financial 
statement data is consistent enough to use as a basis for projecting the following year’s budget.  
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Fifty New Functions in Excel 2013 

  

FUNCTION NAME TYPE AND DESCRIPTION 

1. ACOT function Math and trigonometry:    Returns the arccotangent of a 

number 

2. ACOTH function Math and trigonometry:    Returns the hyperbolic 

arccotangent of a number 

3. ARABIC function Math and trigonometry:    Converts a Roman number to 

Arabic, as a number 

4. BASE function Math and trigonometry:    Converts a number into a text 

representation with the given radix (base) 

5. BINOM.DIST.RANGE 

function 

Statistical:    Returns the probability of a trial result using a 

binomial distribution 

6. BITAND function Engineering:    Returns a 'Bitwise And' of two numbers 

7. BITLSHIFT function Engineering:    Returns a value number shifted left by 

shift_amount bits 

8. BITOR function Engineering:    Returns a bitwise OR of 2 numbers 

9. BITRSHIFT function Engineering:    Returns a value number shifted right by 

shift_amount bits 

10. BITXOR function Engineering:    Returns a bitwise 'Exclusive Or' of two numbers 

11. CEILING.MATH 

function 

Math and trigonometry:    Rounds a number up, to the 

nearest integer or to the nearest multiple of significance 

12. COMBINA function Math and trigonometry:     

Returns the number of combinations with repetitions for a 

given number of items 

13. COT function Math and trigonometry:    Returns the hyperbolic cosine of a 

number 

14. COTH function Math and trigonometry:    Returns the cotangent of an angle 

15. CSC function Math and trigonometry:    Returns the cosecant of an angle 

16. CSCH function Math and trigonometry:    Returns the hyperbolic cosecant of 

an angle 
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17. DAYS function Date and time:    Returns the number of days between two 

dates 

18. DECIMAL function Math and trigonometry:    Converts a text representation of a 

number in a given base into a decimal number 

19. ENCODEURL function Web:    Returns a URL-encoded string 

20. FILTERXML function Web:    Returns specific data from the XML content by using 

the specified XPath 

21. FLOOR.MATH function Math and trigonometry:    Rounds a number down, to the 

nearest integer or to the nearest multiple of significance 

22. FORMULATEXT 

function 

Lookup and reference:    Returns the formula at the given 

reference as text 

23. GAMMA function Statistical:    Returns the Gamma function value 

24. GAUSS function Statistical:    Returns 0.5 less than the standard normal 

cumulative distribution 

25. IFNA function Logical:    Returns the value you specify if the expression 

resolves to #N/A, otherwise returns the result of the expression 

26. IMCOSH function Engineering:    Returns the hyperbolic cosine of a complex 

number 

27. IMCOT function Engineering:    Returns the cotangent of a complex number 

28. IMCSC function Engineering:    Returns the cosecant of a complex number 

29. IMCSCH function Engineering:    Returns the hyperbolic cosecant of a complex 

number 

30. IMSEC function Engineering:    Returns the secant of a complex number 

31. IMSECH function Engineering:    Returns the hyperbolic secant of a complex 

number 

32. IMSINH function Engineering:    Returns the hyperbolic sine of a complex 

number 

33. IMTAN function Engineering:    Returns the tangent of a complex number 

34. ISFORMULA function Information:    Returns TRUE if there is a reference to a cell 

that contains a formula 
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35. ISOWEEKNUM 

function 

Date and time:    Returns the number of the ISO week number 

of the year for a given date 

36. MUNIT function Math and trigonometry:    Returns the unit matrix or the 

specified dimension 

37. NUMBERVALUE 

function 

Text:    Converts text to number in a locale-independent 

manner 

38. PDURATION function Financial:    Returns the number of periods required by an 

investment to reach a specified value 

39. PERMUTATIONA 

function 

Statistical:    Returns the number of permutations for a given 

number of objects (with repetitions) that can be selected from 

the total objects 

40. PHI function Statistical:    Returns the value of the density function for a 

standard normal distribution 

41. RRI function Financial:    Returns an equivalent interest rate for the growth 

of an investment 

42. SEC function Math and trigonometry:    Returns the secant of an angle 

43. SECH function Math and trigonometry:    Returns the hyperbolic secant of an 

angle 

44. SHEET function Information:    Returns the sheet number of the referenced 

sheet 

45. SHEETS function Information:    Returns the number of sheets in a reference 

46. SKEW.P function Statistical:    Returns the skewness of a distribution based on a 

population: a characterization of the degree of asymmetry of a 

distribution around its mean 

47. UNICHAR function Text:    Returns the Unicode character that is references by the 

given numeric value 

48. UNICODE function Text:    Returns the number (code point) that corresponds to 

the first character of the text 

49. WEBSERVICE function Web:    Returns data from a web service. 

50. XOR function Logical:    Returns a logical exclusive OR of all arguments 
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New Features in Word 2013 

Word has a number of PDF improvements that might interest the CPA community. When an 
unprotected PDF file is opened in Word, it instantly is converted to a Word format, ready for 
editing. Once you’ve completed your edits, you can save it as a Word document or back to a PDF 
format. Note: Microsoft cautions that PDF documents opened in this manner may contain minor 
formatting issues—for example, pages may not break exactly as they do in the original PDF file if 
the PDF document contains images, tables, or objects. 

An improvement that reviewers should find useful is Word’s improved Track Changes format and 
threaded review conversations, which make it easier to follow the back-and-forth review 
comments. 

Word’s improved Read Mode provides icons for turning pages with a tap of a finger on touch-
screen devices, with a click of the mouse, or by rolling the mouse’s scroll wheel. Read Mode 
allows you to split a document into side-by-side pages or narrow columns to give documents the 
look and feel of a book—a format that better accommodates speed reading. Double-tapping or 
double-clicking any inserted object (tables, charts, pictures, and videos) expands them to full-
screen size, and you can also stream videos within documents. 

Other Word enhancements include vertical and horizontal alignment guides that pop up 
automatically when you move an image, object, or text box to help you snap them into place 
correctly on the first try. Cropping or resizing images using the mouse is improved to adjust 
images in one-pixel increments, rather than three. When you reopen a Word document, Word 
displays a placeholder tab containing a hyperlink for returning to the last position you were at 
when you closed the document, so you can quickly pick up where you left off. 

New Features in Outlook 2013 

In a significant enhancement, Microsoft has rolled out Outlook.com, which provides cloud-
hosted centralized email accessible from all of your computers and mobile devices. Outlook’s 
new touchscreen tile design and menus work well on smartphones (see screenshot at left). 

Outlook’s look and feel has been improved in several ways. The screens and menus are cleaner, 
and a new Navigation Bar has been added at the bottom, providing quick access to Calendar, 
People, and Tasks. Outlook now provides a Quick Peek into the calendar, contact list, and tasks 
when you hover over these options. 

Outlook’s new People Card can combine disparate sources of contact information (Outlook, 
LinkedIn, Facebook, etc.) into a single contact record and can also display social media status 
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updates, pictures, and activity feeds from all your friends and 
followers. This enhancement enables you to view current 
social media content for senders or recipients as you read or 
compose email, perhaps helping you to remember the 
sender or include a congratulatory comment on the 
recipient’s new grandchild. This approach might help you 
keep up with your friends, colleagues, and connections solely 
from within Outlook. New features also allow you to flag, 
delete, mark, or reply to email messages directly from within 
the reading pane without opening the email, and you can 
share a mailbox folder with others, such as a project team. 

New ActiveSync functionality connects Outlook to 
Outlook.com or Gmail automatically, without the need to 
download, install, and configure a complicated connector. 
This tool also syncs your Outlook.com or Gmail calendars, 
contacts, and other information associated with those 
accounts. Calendar Sharing offers new tools and a variety of 
new methods for sharing calendar details directly from 
within the calendar. 

 

 

New Features in PowerPoint 2013 

PowerPoint’s Presenter View has a new look that privately displays teleprompter-style presenter 
notes, upcoming slides, a presentation timer (with a time restart button), zoom tools, markup 
tools, touchscreen controls, a stylus, and a touch-screen stylus. Additionally, the Presenter View 
no longer requires a second monitor for use; simply press Alt+F5 to run presenter view on a single 
monitor, as pictured in Exhibit 6. 
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When you are making a presentation, the new Slide Zoom allows you to double-click on an object 
or area in a presentation to temporarily enlarge it (pressing the Esc key returns the presentation 
to a normal view). The new Navigation Grid privately displays thumbnail images of all slides on 
the presenter’s screen. New touchscreen gestures such as swipe, tap, scroll, zoom, and pan can 
be used to present slideshows from your tablet, smartphone, or other touch-screen device. A 
welcome enhancement is the new Review Pane (see Exhibit 7), which features threaded 
comments and replies similar to those found in Word 2013. 
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PowerPoint enables you to present live online meetings free via Microsoft Lync, and this platform 
can now deliver live video and audio with slideshow presentations. Lync allows you to host an 
unlimited number of audience participants (in some versions), send invitations via email, mute 
audience members, block audience video, and hide names from other audience attendees. 
Another noteworthy improvement is Lync’s ability to seamlessly play slideshow-embedded video 
clips from within the presentation. 

PowerPoint features more than a dozen new templates and themes, most of which are designed 
for the newer 16:9 (HD aspect ratio) widescreen monitors and flat screen TVs and projectors. 
There are 22 new transitions, including Paper Curl, Ferris Wheel, Orbit, Fly Through, Vortex, and 
Doors, to name a few. 

On the slide master, alignment guides can be placed to ensure that slide elements are positioned 
consistently across all slides. A new option enables you to merge shapes to form a single shape, 
and text can wrap tightly to that new shape for a professional effect. Because PowerPoint is 
frequently used with a projector, Microsoft added improved capabilities that will not only detect 
the presence of a projector, but will also automatically adjust the video output size and resolution 
settings for optimum visibility. Creating motion paths for text boxes and objects is easier now 
with new ghost images that visually show the user where the animated objects will end in 
relation to their starting point (shown in the screenshot below). 
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PowerPoint also added a color Eyedropper that makes it easy to match colors (shown in the 
screenshot below). 

 

 
 

OneNote 2013 Enhancements 

OneNote features a new splash screen; Note Sync between all of your devices (including 
Windows, Android, and Apple phones); drag and drop whole files; new inking tools for drawing, 
erasing, editing, and doodling; improved tables with shading, header rows, and data sorting; a 
mobile app for Android and Apple phones; a new radial menu for easier touch-screen access; 
touch, pen, or keyboard note-taking; the ability to send notes to a webpage; embed Excel 
workbooks or Visio diagrams; and search by author capability. 

Access 2013 Enhancements 

Access 2013 offers improved relational and multi-table support including a multiple-table 
indicator for building true relational databases; views from one table automatically display data 
from related tables; related-item controls automatically summarize data from related tables and 
queries; drill-through clicks employ behind-the-scenes logic to display data from related sources. 

In addition, there are new tools for building a browser-based database app, 2010 web-style 
database, or traditional desktop database; a browser-based database app automatically creates 
views and switchboards; new table templates; controls dragged and dropped onto views snap to 
layout guides automatically; hovering over callouts displays editable properties; and Access now 
supports three permission levels for author, developer, and reader. 
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Alternatives suites to Microsoft Office 

Microsoft Office (priced starting at $119.99 or $15 per month) commands an estimated 90% to 
95% of the U.S. application suite market. The top five alternatives to Microsoft Office are Corel’s 
WordPerfect Office (priced starting at $229); IBM’s Lotus SmartSuite (priced starting at $19.99); 
Oracle’s OpenOffice (free); Google Docs (free); and Google Apps for Business (priced starting at 
$5 per month).  

How much should a new system cost? 

Selecting a new computer system is confusing, and no one solution fits all. However, you may 
find it useful to consider the desktop system I use for comparison purposes. In January 2013 I 
purchased a new 64-bit, Windows 8 HP Envy computer for $849 (with 12 GB of RAM, running 
Intel Core i7-3770 at 3.40 GHz) and installed Office 2013 at a subscription cost of $20 per month. 
I kept my two 40-inch monitors ($299 each) and webcam ($50). I added QuickBooks Premier 
Accounts Edition ($20 per month), Adobe Acrobat XI ($119), Adobe Photoshop Elements ($71), 
Camtasia Studio 8 ($149), and Snagit ($39). The resulting computer system is fast and reliable, 
and all of my data and email messages are accessible from my office computer, home computer, 
laptops, tablet, and smartphone. 

Upgrade Advice for CPAs 

CPAs have much to consider as they weigh a possible jump to Office 2013 (see the sidebar “Office 
2013: Rent or Buy?”).  

Technology leaders will likely embrace the new Office, while laggards will likely hold off as long 
as they can. Most CPAs fall in the middle, and in my view, upgrading to Office 2013 makes more 
sense for the following groups of CPAs: 

1. CPAs on Windows 8, because Office 2013 is designed to work in the Windows 8 environment. 

2. CPAs operating in the cloud, because Office 2013 provides new features and functions for 
accessing data in the cloud, running applications from the cloud, and sharing data through the 
cloud. There are caveats to this, however, which are covered in the sidebar “Office 2013: Rent or 
Buy?” 

3. CPAs with touch-screen monitors, because Office 2013 is touch-screen enabled. (Please note 
that Office 2013’s touch-screen tiles will respond to mouse clicks, even in the absence of a touch-
screen monitor.) 

4. CPAs who want to use Office on their mobile tablets or smartphones, because Office’s new 
tile-based buttons, touch-screen controls, and phone-friendly menus help Office operate better 
on mobile devices. 
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5. CPAs on Office 2003 or earlier, because those editions of Office are well behind the times and 
Office 2013’s enhancements are sufficient to warrant an upgrade. 

6. CPAs on Office 2010 or 2007 who find the new features essential, because Office 2013 
includes many significant enhancements, just one of which could justify upgrading. 

The following groups of CPAs may find staying on Office 2010 a reasonable strategy: 

1. CPAs using Windows Vista or XP have no choice but to stay put because Office 2013 does not 
run on those platforms. 

2. CPAs remaining on Windows 7, because Windows 7 does not support touch-screen, therefore 
Office 2013’s new tiles and touch-screen capabilities will be less meaningful. 

3. CPAs who are satisfied with their current computer systems and are not yet ready to fully 
embrace the cloud, touch-screen monitors, tablets, or smartphones should probably hold off 
upgrading. If your systems and software are fairly current and working well, you need compelling 
reasons to justify the upgrade costs, installation effort, and inherent learning curve. If the cloud 
and mobile-device solutions and feature enhancements described herein aren’t compelling 
enough, then staying put may be a reasonable strategy for now. 

In the final analysis, most CPAs won’t jump to the new technology right away—and rightfully so. 
It probably makes the most sense to upgrade to the latest editions of Windows and Office the 
next time your computers need replacing. However, tech-savvy CPAs should find enough new 
functionality to warrant transitioning to Office 2013 sooner rather than later. 
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Consolidating Data in Excel 
 
Consolidating data is a common task for CPAs, and Excel offers a variety of methods for 
performing this task. The particular method you use will probably depend on the layout of your 
data, and you may need to clean, edit or manipulate your data a bit to prepare it for 
consolidation. CPAs often have a need to consolidate data such as budgets, months, 
departments, locations, warehouses and sale representatives. 

 
Following I will explain four different consolidation methods - two methods for consolidating data 
with similar layouts, and two more methods for consolidating data with dis-similar layouts. These 
four methods are as follows: 
 

A. Simple formulas. 
B. Spearing formulas. 
C. The “Data Consolidate Command”. 
D. The “PivotTable Wizard”. 

 

A. Using Simple Formulas To Consolidate Similar Data  
 
The workbook below contains budgets with identical layouts for Departments A, B, C and D. 
The goal is to consolidate these four budgets into a single consolidated budget. 

  

 
  

http://www.carltoncollins.com/


Office 2013 for CPAs 

www.CarltonCollins.com Page 31 Copyright August 2013 

 

1. Insert a New Worksheet on which the consolidation will appear 
 

i. Don’t click the New Sheet or Add Sheet Option - Because there is a better 
and quicker approach. 
 

ii. CTRL + Drag Tab – To insert a new worksheet, select worksheet labeled 
“Dept D”; then use the CTRL + Drag Tab keystroke combination to create a 
duplicate worksheet of Dept D. The advantage is that the data, column 
widths, page footers and headers, and margin settings are all duplicated 
automatically, so you don’t have to create a new page from scratch. 

 

 
 

iii. (The menu method for achieving this same procedure is to right click on 
the tab and select Move or Copy, but CTRL + Drag Tab is quicker.) 

 
iv. Clean the Page – Clean the new worksheet by deleting the data in the grid 

area, so that new formulas can be inserted.  
 

     
 

v. Re-label – Change the worksheet label in Cell A1 and on the Worksheet 
Tab to read “consolidated”. 

 

http://www.carltoncollins.com/


Office 2013 for CPAs 

www.CarltonCollins.com Page 32 Copyright August 2013 

 

     
 

2. Formula – In cell B5, enter a formula adding the B5 cells in the four budget sheets. 
The formula should look like this: 

 

='Dept A'!B5+'Dept B'!B5+'Dept C'!B5+'Dept D'!B5 
 

3. Copy – Copy the formula down and across to complete the consolidation, and you 
are done. 
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B. Using Spearing Formulas To Consolidate Similar Data  
 

The workbook below contains budgets with identical layouts for Departments A, B, C and D. 
The goal is to consolidate these four budgets into a single consolidated budget. 

  

 
 

1. Insert a New Worksheet on which the consolidation will appear 
 

i. Don’t click the New Sheet or Add Sheet Option - Because there is a better 
and quicker approach. 
 

ii. CTRL + Drag Tab – To insert a new worksheet, select worksheet labeled 
“Dept D”; then use the CTRL + Drag Tab keystroke combination to create a 
duplicate worksheet of Dept D. The advantage is that the data, column 
widths, page footers and headers, and margin settings are all duplicated 
automatically, so you don’t have to create a new page from scratch. 
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iii. (The menu method for achieving this same procedure is to right click on 
the tab and select Move or Copy, but CTRL + Drag Tab is quicker.) 

 
iv. Clean the Page – Clean the new worksheet by deleting the data in the grid 

area, so that new formulas can be inserted.  
 

     
 

v. Re-label – Change the worksheet label in Cell A1 and on the Worksheet 
Tab to read “consolidated”. 

 

     
 

2. Formula – In cell B5, enter a formula adding the B5 cells in the four budget sheets. 
The formula should look like this: 

 

=SUM('Dept A:Dept D'!C5) 
 
I use the mouse to accomplish this step. Start by typing “=SUM(“, then click on cell B5 in 
Dept A, hold the shift key down, and click cell B5 in Dept D.  
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3. Copy – Copy the formula down and across to complete the consolidation, and you 
are done. 
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C. Using the “Data Consolidate Command”  
To Consolidate Dissimilar Similar Data 
 

The workbook below contains dis-similar budgets for Departments A, B, C and D. 
Specifically, the four worksheets contain budgets for separate departments, and some 
budgets contain more rows and different row descriptions than others. The goal is to 
consolidate these four departmental budgets using the Consolidate Command. 

  

 
 

1. Create A New Worksheet – Insert a new worksheet. Because there is no need to 
duplicate a template from another worksheet you might be tempted to use the New 
Sheet button this time; however, this approach does not duplicate the worksheet’s 
page footers, headers or margin settings. Therefore I would still recommend that you 
use the CTRL + Drag Tab method as described in examples 1 & 2 above to create a 
new sheet, and I would then eliminate the data on the new sheet by deleting those 
columns that contain data. 
 

2. Label – As before, label the new worksheet in Cell A1 and on the Worksheet Tab to 
read “Consolidated”. 
 

3. Select Cell – Select a blank cell on the new worksheet such as B3.  
 

4. Use the Consolidate Command - From the Data tab, select Consolidate to display the 
Consolidate dialog box as pictured below. Click the Cell Chooser button, then highlight 
the data only on Dept A, click Enter, and then click Add. Repeat this process for Dept 
B, Dept C and Dept D. 

 

http://www.carltoncollins.com/


Office 2013 for CPAs 

www.CarltonCollins.com Page 37 Copyright August 2013 

 

 
 

5. Check the check boxes to use Labels in the Top Row and Left Column.   
 

6. Finish – Click OK to produce the results. 
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7. Add Totals and Formatting - Highlight your data and expand the selection to include 

a blank bottom row and blank right column. Click the AutoSum tool, add formatting 
and you are done. 

 

 
 

Comments: 
 

 Row Descriptions - Note that the consolidation works only to the extent that the 
different worksheets contain the same row descriptions. If your four department 
heads had used the descriptions: Rent, Rent Exp., Rent Expense, and Rental Expense, 
then those rows would not actually be consolidated, rather they would be shown as 
four separate rows in the resulting consolidation. However, because all four 
department heads did use the phrase Rent to describe that row, the four respective 
rent rows were properly consolidated.  

 

 Account Numbers – As an option, you might insert account numbers to the left of the 
row descriptions to consolidate dissimilar information which contains dis-similar row 
descriptions.  
 

 To Update – To update the results, place your cursor in the upper left hand corner of 
the Consolidation range, and rerun the Consolidate command. If the resulting report 
is a different size, you may need to clean up your data and reapply totals.  
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 Consolidate Different Workbooks – Excel can also consolidate data from different 
workbooks. The procedure is exactly the same except that you use the Browse button 
instead of the Cell Chooser button to point to your data ranges.  

 
The Problem with Data Consolidate 
 
The problem with Data Consolidate occurs when you attempt to change the source data, for 
example when you insert a new row in Dept A; a comedy of errors ensues as follows: 
 

1. When you change the source data, the consolidated report does not update automatically. 

2. Pressing the Refresh button does nothing. 

3. To update the consolidated report, you must rerun the data consolidate command. But upon re-
running this command, you find that your cursor needs to be in the exact same location when 
you ran it last time. 

4. You also find that you need to erase the previous data before re-running the Data Consolidate 
command. 

5. Next you find that in Excel 2003, 2007 and 2010, you need to re-adjust your consolidating range 
for Dept A because the tool did not automatically expand the selection when the row was 
inserted in Dept A. (This issue has been corrected in Excel 2013.)  

Because source data tends to change frequently, you are probably better off using the next 
method to consolidate your data - the PivotTable and Chart Wizard method.  
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D. Using A PivotTable To Consolidate Dissimilar Similar Data 
 
The workbook below contains the same dis-similar budget data used in example 3 above. The four 
worksheets contain budgets for separate departments, and some budgets contain more rows and 
different row descriptions than others. The goal is to consolidate these four departmental budgets using 
the PivotTable approach. 

  

 
 

1. Create A New Worksheet – Start by inserting a new worksheet. (Because there is no need 
to duplicate a template from another worksheet you might be tempted to use the New 
Sheet button this time; however, this approach does not duplicate the worksheet’s page 
footers, headers or margin settings. Therefore I would still recommend that you use the 
CTRL + Drag Tab method as described in examples 1 & 2 above to create a new sheet, and 
I would then eliminate the data on the new sheet by deleting those columns that contain 
data.) 
 

2. Label – Label the new worksheet in Cell A1 and on the Worksheet Tab to read 
Consolidated. 
 

3. Select Cell – Select a blank cell such as B3.  
 

4. Add the PivotTable Wizard to Your Quick Access Toolbar – The PivotTable Wizard in Excel 
2003 allows you to pivot multiple consolidation ranges, but for unknown reason this tool 
is hidden in later versions of excel. Therefore, in Excel 2013, 2010 and 2007, you must first 
customize your Quick Access toolbar and insert the icon titled PivotTable and PivotChart 
Wizard as shown below.  
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To add this tool, right-click your Quick-Access toolbar, select Customize Quick Access 
Toolbar, select the option to View All Commands, locate the PivotTable and PivotChart 
Wizard icon and add it to your toolbar. The resulting toolbar will appear as follows.  .  

 

 
 

5. Run the PivotTable Wizard – Click the PivotTable and PivotChart Wizard icon to display 
the PivotTable and PivotChart Wizard dialog box as shown below. Choose the Multiple 
consolidation ranges option and click Next, and Next again. The dialog box on the right 
should now be displayed. 

 

   
 

Click the Cell Chooser button, then highlight the data only on Dept A, click “Enter”, and 
then click “Add”.  
 

 
 
Repeat this process for Dept B, C and D until the PivotTable Wizard appears as follows. 
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6. Finish – Click “FINISH” to produce the results. 
 

 
 

7. Add Formatting - Highlight your data and add comma formatting with no decimals, adjust 
the columns widths to taste, center the column headings; then you are done. 
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Comments: 
 
The PivotTable Wizard approach is superior to the Data Consolidate approach for many reasons as 
follows: 
 

1. Totals are automatic inserted with the PivotTable method. 

2. Total column and row labels are automatically inserted with the PivotTable method. 

3. AutoFilter buttons are automatic inserted with the PivotTable method. 

4. If the source data changes, such as inserting a new row in Dept A, simply click refresh to update. 

5. The resulting PivotTable is drillable. 

6. The resulting PivotTable can be pivoted. 

7. The PivotTable report offers many PivotTable tools such as PivotTable formatting which Data 
Consolidate does not offer. 

 

Download these Consolidation example templates at: 

www.CarltonCollins.com/consolidatesimilarbudgets.xlsx 

www.CarltonCollins.com/consolidatedissimilarbudgets.xlsx 
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Data Analysis Tools 
 
Preparing Data for Data Analysis 
 
Before you start to analyze data using Excel’s various data commands such as Sort, Autofilter, 
Subtotal, Grouping, Consolidate, or PivotTable, you should first inspect your data to determine 
if it is in Analysis-Ready condition. In general, this means that the data must meet the following 
criteria: 
 

a. Contiguous Data – The data should contain no blank rows or blank columns. For example, 
the screen below shows blank rows (with solid lines). These rows should first be removed 
before proceeding with the creation of a PivotTable. 
 

 
 

b. Single Row Data – Some accounting systems produce data that spans two or more rows 
per transaction. If this is the case, your will need to clean that data so that all related 
information for a single transaction or data is contained on a single row. For example, the 
following data contains multiple rows of data related to a single sales order. In this case, 
the user must move and paste the data to fall on a single row. This is an example of data 
that requires a great deal of clean up. 
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c. Column Headers -  The data should contain a unique header atop each column. For 
example, the following screen contains two columns labeled Date, while columns D and 
E contain no heading. These are both cases of data that should be cleaned before creating 
a PivotTable.  
 

 
 
If you attempt to analyze data that does not contain a column heading atop all columns, 
you will sometimes receive an error message, such as the example shown below. 
 

 
 
If you have data with the same column heading used more than once, Excel will 
sometimes alter the column headings, for example when you create a PivotTable, so all 
headings will be unique. 
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d. Row Descriptions – Generally, your data should repeat row descriptions for each row. For 
example, the screen below shows that the state and city descriptions are not repeated 
for each row in columns A & B.  
 

 
 
A solutio for quickly filling in the missing row descriptions is presented later in these 
materials. 

 
e. Transposing Headers and Rows – In some cases, data may need to be transposed because 

many of Excel’s Data tools use the column headings, not the row headings to crunch the 
data. To do this, copy the data, then select Paste Special, Transpose, OK to flip the data 
around.   
 

f. Clean Data – The data must be clean of empty text cells containing spaces, special 
characters, extra spaces within data, trailing spaces, trailing zeros, leading zeros, etc.  
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Data Analysis Tools 
 
Excel provides specialized tools for analyzing data and generating financial reports, yet most CPAs 
are unaware of these tools or haven’t tried using them before. Specifically useful are the  
Subtotaling, Grand Totaling, Filtering, Consolidating, Grouping & Outlining, Drilling, OLAP Data 
Cubes, PivotTables, Sparklines, Data Bar Reporting, Conditional Formatting, Charting, Foot 
Notes and End Notes, Formula Auditing Tools, Error Checking, Functions, and Data Analysis 
Tools. 
 
The concepts discussed are intended to directly aide the CPA in summarizing, slicing, dicing and 
analyzing data, and generating related financial reports. 
 
2013 Data Ribbon: 
 

 
 
2013 Insert Ribbon: 
 

 
 

  

http://www.carltoncollins.com/


Office 2013 for CPAs 

www.CarltonCollins.com Page 48 Copyright August 2013 

 

Data Sort 
 
You would think that every Excel user would already know all about sorting data in Excel, but I am 
frequently surprised to find that many users have missed a few key points related to using this 
tool. I don’t mean to belittle you are talk beneath you, but humor me a copy of paragraphs and 
let’s make sure you are fully up to speed on the following key sorting points: 
 
1. Contiguous Data - The “A to Z” sorting tool can sort a large matrix of data without having to 

highlight the area as long as the data is contiguous; that is to say that your data should contain 
no blank columns, no blank rows, and the columns must all be labeled with a column heading. 
When data is contiguous, all you need to do is place your cursor in a single cell in a given 
column and click the Sort A to Z or Sort Z to A buttons, and Excel will automatically select the 
entire matrix for sorting. Surprisingly many users waste a great deal of time highlighting sort 
ranges prior to sorting, but this step is often unnecessary. 
 

2. A to Z Button - Simply place the cursor in the desired column for sorting, and press the A to Z 
or Z to A button as the case may be. Excel will automatically sort all continuous columns that 
have headings and all contiguous rows from the top row under the heading labels down to the 
last row in the selected column that contains data. (Note - If you accidently select 2 cells 
instead of just one, your results will not be correct.) 

 
3. Sort by 64 Columns - The “Sort” tool was enhanced beginning in Excel 2007 as it now provides 

the ability to sort by up to 64 columns, instead of just 3 columns. Presented below is a dialog 
box which shows this expanded functionality.  
 

 
 

4. Sort Left to Right – Excel has always provided the ability to sort left to right. To do so, select 
the Sort Options box in the Sort dialog box and click the check box labeled Sort Left to Right 
as pictured below. 
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5. Sort by Color – beginning with Excel 2007, you can also sort by font color or by cell color, or 
both. This is handy in many ways. Sometimes CPAs use color to tag or mark certain cells - and 
later find it useful to be able to sort by those markings. In other situations CPAs use conditional 
formatting to apply color to cells using a wide variety of rules; and thereafter they can sort the 
data based on the resulting conditional colors. The two sort-by-color options are pictured 
below. 
 

 
    

To be fair, it was sort of possible to sort by color in Excel 2003. To accomplish this task, you 
needed to use the CELL function in order to identify information about a given cell such as the 
cell color or font color. Thereafter, the results of that function could be used to sort rows – 
which effectively means that you can sort by color in Excel 2003 – but it takes a bit more effort. 
 

6. Sort By Custom List – Another sorting capability in Excel is the ability to sort by Custom List. 
For example, assume a CPA firm has ten partners, and the Managing partner prefers to be 
shown at the top of the list, and the remaining Partners based on seniority. In this case, you 
could create a Custom List in the Excel Options dialog box listing the partners in the desired 
order, and then sort future reports based on that order. 
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To access the Custom List settings: 
 
1. In Excel 2013 & 2010, select File, Options, Advanced, and scroll to the bottom, and then 

select Edit Custom List. 
 

2. In Excel 2007, select File, Options, select Edit Custom List option a few inches down from 
the top. 
 

3. In Excel 2003, select Tools, Options, and click the Custom Lists tab.  
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Filtering Data 
 
AutoFilter allows you to view a subset of your data and when you are done, you can clear the 
filters to once again redisplay all of your data. To use this tool, start with any list of data and turn 
on the AutoFilter tool. Then position your cursor in the column you want to filter and use the 
drop down arrows to apply your filters as suggested in the screen below. 
 

 
 

Once the filters are applied, you will see a subset of your data. For example, the screen presented 
below shows filtered data for only Macon and Savannah properties.  

 

 
 
As filters are applied, a small funnel icon appears in the drop down arrow button to indicate that 
a filter has been applied to that particular column. 
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Key Points Concerning the AutoFilter Command: 
 

1. Contiguous Data – The AutoFilter tools works best when you are working with data that is 
contiguous. In other words, your data should contain no blank columns, no blank rows, 
and the columns must all be labeled.  
 

2. Column Headings –Your columns need unique column headings in and single row, and if 
the column headings are not in row 1, then the row above the column headings should be 
blank so Excel will auto detect the correct range.  
 

3. Filter by Multiple Columns - You can filter by more than one column. 
 

4. Filters are Additive - Each additional filter is based on the current filter and further reduces 
the subset of data. 

 
5. Removing Filters – In all editions of Excel, a fast way to remove multiple filters is to turn 

AutoFilter off and then turn AutoFilter back on. In Excel 2007 and later editions, you can 
also click the Clear button in the Sort & Filter Group as pictured below.  
 

 
 

6. Filter by Color – You can filter based on colors. For example, you can filter by cell color or 
by a list of numbers, you can filter by icon or by a custom filter.  
 

 
 

Note that the Color Filter is mutually exclusive as you cannot also filter by value or text 
when filter by color is applied, and vice versa. 

 

7. Filters Enabled - A drop-down arrow  means that filtering is enabled but not applied. 
 

8. Filter Applied - A Filter button  means that a filter is applied. 
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9. Filter Spanning - The commands 

under the All Dates in the Date 
Filters menu, such as January or 
Quarter 2 filter by the period no 
matter what the year. This can be 
useful, for example, to compare 
sales by a period across several 
years. 
 

10. This Year vs. Year-to-Date - This 
Year and Year-to-Date are 
different in the way that future 
dates are handled. This Year 
filtering can return dates in the 
future for the current year, 
whereas Year-to-Date only 
returns dates up to and including 
the current date based on the 
computer’s time clock. 
 

11. Filtering Dates - All date filters are based on the Gregorian calendar as decreed by Pope 
Gregory XIII, after whom the calendar was named, on 24 February 1582. The Gregorian 
calendar modifies the Julian calendar's regular four-year cycle of leap years as follows: 
Every year that is exactly divisible by four is a leap year, except for years that are exactly 
divisible by 100; the centurial years that are exactly divisible by 400 are still leap years. For 
example, the year 1900 is not a leap year; the year 2000 is a leap year. 

 
12. Filtering By Days of Week - If you want to filter by days of the week, simply format the 

cells to show the day of the week, or 
insert a new column and use the 
WEEKDAY function to calculate the 
week day, and then apply filters using 
this new column. 
 

13. Top & Bottom Filtering - On the Data 
tab, in the Sort & Filter group, click 
Filter. Point to Number Filters and 
then select Top 10. To filter by 
number, click Items. To filter by 
percentage, click Percent. Note - Top 
and bottom values are based on the 
original range of cells or table column 
and not the filtered subset of data. 
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14. Above & Below Average Filtering - On the Data tab, in the Sort & Filter group, click Filter. 
Select Number Filters, Above/Below Average. Note – These values are based on the 
original range of cells or table column and not the filtered subset of data. 
 

15. Filtering Out Blanks - To filter out blanks, in the AutoFilter menu at the bottom of the list 
of values, de-select the check box labeled Blanks. 
 

16. Filtering By Color - Select Filter by Color, and then depending on the type of format, select 
Filter by Cell Color, Filter by Font Color, or Filter by Cell Icon. Note that these filter options 
only show up when there are actual cell colors, font colors or icons included in the data 
range.  
 

17. Filter by Selection - To filter by text, number, date, time, or color for selected cell(s), select 
the cells to be used as a filter basis and then right-click that selection, and from the popup 
menu select Filter, Filter by Selected Cell's Value, (or Filter by Selected Cell's Color, Filter 
by Selected Cell's Font Color, or Filter by Selected Cell's Icon). 
 

 

 
 

18. Refreshing Filters - To reapply a filter after the data changes, click a cell in the range or 
table, and then on the Data tab, in the Sort & Filter group, click Reapply. 
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Data Form 
 
Excel’s Data Form tool provides a data input window which makes Excel look and behave more 
like a database, such as Microsoft Access. (Note that in Excel 2013, 2010 and 2007, the Form tool 
button has not been included on the Ribbon, so to use it you will first need to add the Form tool 
button to the Quick Access Toolbar.)  
 

 
 

A data form provides a convenient means to enter or display one complete row of information 
in a range or table without scrolling horizontally. Some people, especially those who are used to 
using databases, find that using a data form can make data entry easier than moving from column 
to column when you have more columns of data than can be viewed on the screen.  
 
Key Points using Data Form: 
 

1. You cannot print data from a data form. 
  
2. Because a data form is a modal dialog box, you cannot use either the Excel Print command 

or Print button until you close the data form.  
 
3. You might consider using the Windows Print Screen key to make an image of the form, 

and then paste it into Microsoft Word for printing. 
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Data Subtotals 
 
Excel’s Subtotal command automatically calculates and inserts subtotals and grand totals in your 
list or table. Once inserted, Excel recalculates subtotal and grand totals as you enter and edit the 
detail data. The Subtotal command also outlines the list so that you can display and hide the 
detail rows for each subtotal. Examples of the Subtotal dialog box and a resulting subtotaled 
table are shown below. 
 

  
 

 
 

To display subtotals and grand totals at the top instead of the bottom, deselect the checkbox 
labeled Summary below data.  
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Key points to Consider When Using Subtotaling are as follows: 
 

1. Contiguous Data – The Subtotal tools works best when you are working with data that is 
contiguous. In other words, your data should contain no blank columns, no blank rows, 
and the columns must all be labeled.  
 

2. Sort Before You Subtotal - You must sort the data by the column you wish to subtotal by, 
else you will receive erroneous results.  

 
3. Other Mathematical Applications - The Subtotal tool not only calculates subtotals, but it 

can also calculate minimums, maximums, averages, standard deviations, and other 
functions.  

 

 
 

4. Subtotals in 2013, 2010 & 2007 Tables – Excel 2007 added a new Table tool which enables 
Subtotals a little differently; the Subtotal tool appears at the bottom of each column in 
each Table, as shown in the screen below. 
 

 
  

5. Automatic Outlining – The Subtotal tool automatically inserts Outlines, which allows you 
to collapse or expand your data.  
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6. Copying Outline Data - Some CPAs also like to copy and paste collapsed subtotal data to 
another location, but they find this process copies and pastes all of the data – not just the 
summary data they desire. In this situation, there are two ways to achieve a clean copy 
and paste without grabbing all the hidden data as follows: 
 

a. CTRL key – Hold the Control Key down while you individually click to select 
individual rows; this action will enable you to copy and paste selected data. 
However, this approach can sometimes be problematic because if you miss-click, 
you have to start over. 

 
b. Select Visible Cells – A better approach is to use the Select Visible Cells tool. This 

tool will select on the data you can see, after which the copy and paste routine 
will yield the desired results. This option is better because it is faster and less error 
prone.  

 

 
 

c. Go To – You can also select visible cells using Go To. To do this, press F5 to launch 
the Go To tool and then click Special. In the Go To Special dialog box, select the 
radio button labeled Select Visible cells and press OK.    
 

 
 

d. ALT + ; - The Alt + ; key combination is the shortcut to using the Select Visible Cells 
Tool.  
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Data Validation  
 

Data Validation can be used to limit the data that can be entered into a cell. For example, you 
might want the user to enter only values between 1% and 99%. You might also use this tool to 
enable data input to a drop down list which offers two advantages in that it can be faster and 
more accurate.  To create a dropdown list, enter a list into sequentially cells in Excel. Next, from 
the Data tab select Data Validation, Data Validation (yes, again), then in the dialog box (as shown 
below) select List from the Allow dropdown box and then indicate the data range for your list in 
the Source box. 
 

 
 
After making all the necessary selections in the validation list dialog box, your worksheet will 
produce a cell containing a drop down list (shown in cell A10 below) that behaves as shown.  
 

 
 
You can also provide messages to define what input you expect for the cell, and instructions to 
help users correct any errors. For example, on a worksheet, you can set up a cell to allow only 
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account numbers that are exactly three characters long. When users select the cell, you can show 
them a message such as this one: 
 

 
 
If users ignore this message and type invalid data in the cell, such as a two-digit or five-digit 
number, you can display an actual error message. In a more advanced scenario, you might use 
data validation to calculate the maximum allowed value in a cell based on a value elsewhere in 
the workbook. In the following example, the user has typed $4,000 in cell E7, which exceeds the 
maximum limit specified for commissions and bonuses. 
 

 
 
If the payroll budget were to increase or decrease, the allowed maximum in E7 would 
automatically increase or decrease with it. 
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Data Table (“What-if Analysis”)  
 
Data tables are part of the collection of what-if analysis commands, which include:  
 

1. Data Tables 
2. Goal Seek 
3. Scenarios 

 
The Data Table command enables the process of changing values in cells to see how those changes 
will affect the outcome. For example, you can use a data table to vary the interest rate and term 
length used in a loan to determine possible monthly payment amounts.  
 
There are two types of Data Tables – One Way and Two Way. A data table cannot accommodate 
more than two variables. If you want to analyze more than two variables, you should use 
scenarios. Although it is limited to only one or two criterion (one for the row input cell and one 
for the column input cell), each criterion can include as many different variable values as you want. 
(In contrast, a Scenario can have a maximum of 32 different criterion, but you can create as many 
Scenarios as you want.) 
 
Loan Analysis Example  
 
In this exercise, we start by creating a simple Payment function to calculate the payment amount 
of a loan given a loan amount, interest rate and number of periods.  
 

 
 

The next step is to create a Two-Way Data Table displaying the resulting payment amount given 
a variety of lengths of the loan. This process is started by creating a list of the alternative loan 
amounts, as shown below in B8, B9, B10, etc. Cell C7 must reference the results you want to be 
displayed in the table. 
 

http://www.carltoncollins.com/


Office 2013 for CPAs 

www.CarltonCollins.com Page 62 Copyright August 2013 

 

 
 
Next, highlight the data table range and use the Data Table command on the Data tab (as 
shown below) to generate the desired table. 
 

  
 

This process will generate the following table: 
 

 
 
This table tells us that the same loan amount will require a monthly payment of $4,972 to pay 
the loan off in just 6 years, or a monthly payment of $5,800 to repay the loan in just 5 years.  
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The next step in this exercise is to generate a line chart based on the data table we just created. 
This line chart will provide some interesting observations regarding the benefits and detriments 
of paying off loans over longer periods. 
 

 
 

The resulting chart is shown as follows: 
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Based on this, no one should ever obtain a fair market loan for more than 15 years, the reduction 
in payments simply aren’t worth the additional length of the loan. This same basic behavior is 
seen whether the interest rate is 1% or 100%, or whether the loan amount is $1,000 or 
$10,000,000. The only time you might be justified in obtaining a loan longer than 15 years might 
be when you are extended a favorable interest rate (perhaps from a rich uncle), better than a fair 
market interest rate. 
 

Goal Seek 
 
If you know the result that you want from a formula, but are not sure what input values are 
needed to produce your desired results, use Goal Seek. For example, suppose that you have 
decided to purchase a house, but you don’t know how much house you can afford. In this case, 
know how the interest rate (3.75%) and how long you want to take to pay off the loan (15 years), 
and the amount you can afford to pay each month ($2,800). In this case, you can use Goal Seek 
to work backwards to figure out how much house you can afford. Start by calculating the monthly 
payment based on any random home loan amount as pictured below.  
 

 
 

Next, from the Data tab, select What-If Analysis, Goal Seek. Fill in the parameters to set the 
payment amount to $2800 by adjusting the Loan Amount, as shown, and then click OK.  
 

 
 

The result is that a person with $2,800 available to make monthly payments can afford to 
purchase a home costing up to $385,027 (assuming a 15 year loan and 3.75% interest rate) – as 
pictured above. (Keep in mind that anyone actually following this scenario would need to 
consider that homes also come with other monthly obligations including real estate taxes, 
insurance maintenance, etc.)   
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Data - Text to Columns 
 
CPAs sometimes receive data from their clients or IT departments that is in text form. When this 
happens, Excel can split the contents of one or more cells in a column and distribute those 
contents as individual parts across other cells in adjacent columns. For example, the worksheet 
below contains a column of full names and amounts that you want to split into separate columns. 
The Text to Columns wizard parses the data automatically into separate cells. To use this tool, 
select the cell, range or entire column that contains the text values that you want to split.  
 

 
 
 
 
 
Notes:   
 

1. A range that you want to split can include any number of rows, but it can include no more than 
one column.  
 

2. You also should make sure there are enough blank columns to the right of the selected column to 
prevent overwriting existing data in those adjacent columns. 
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Flash Fill  
 
Of all the Office 2013 applications, Excel is the beneficiary of the most impressive enhancements. 
Excel’s new Flash Fill watches you work and applies logic to help you complete your tasks. The 
example pictured below contains a list of 44 first and last names in Column A, which I want to 
separate into Columns B and C. As I start typing the first name of the second record in Column B; 
Excel’s Flash Fill guesses what I’m trying to do and offers to fill in the remaining 42 first names 
(as shown in grey text). 
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Data Grouping & Outlining  
 
If you have a list of data that you want to group and summarize, you can create an outline of up 
to eight levels. Each inner level (represented by a higher number in the outline symbols) displays 
detailed data for the preceding outer level, represented by a lower number in the outline 
symbols. Use an outline to quickly display summary rows or columns, or to reveal the detail data 
for each group. You can create an outline of rows (as shown in the example below), an outline of 
columns, or an outline of both rows and columns. 
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PowerView 
 
Excel’s new PowerView inserts new worksheets connected to your data, and then enables you 
to create new report types, such as the interactive map chart presented below. The resulting 
PowerView Map report is zoomable, and filters can be applied to display partial data. 

 

 
 
PowerView worksheets can be published as standalone, interactive reports to Microsoft 
SharePoint’s PowerPivot Gallery or other reporting service destinations. Some of the tools 
provided by PowerView include the ability to create a dashboard containing multiple 
PowerViews, apply themes and backgrounds, insert pictures and text boxes, insert collapsible 
and expandable tiles, and add data slicers.  
 
PowerView Learning Points 
 

1. Included - PowerView isn’t included in Office Home editions. Power View and PowerPivot are only 
available in the Office Professional Plus and Office 365 Professional Plus editions.  

2. Worksheet - PowerView is another sheet in the workbook, and acts like a Dashboard.  
3. Fields – Add data to the PowerView by selecting fields, much like you do for PivotTables. 
4. Play - You can play charts to see how they change over time. 
5. PowerView uses PowerPivot - Known to be extremely fast for retrieving and sorting data.  
6. Relationships – PowerView can integrate multiple data sets via relationships. 
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Timeline Slicer 
 
CPAs who work with PivotTables will likely appreciate Excel’s new Timeline Slicer which helps 
users slice and dice Pivot data that contain dates. As an example, selecting the dates May through 
October on the Timeline slicer pictured below adjusts the PivotTable to display May thru October 
data.  

 

 
 

 

Quick Analysis 
 
Excel’s Quick Analysis tool also helps you analyze data by offering a variety of formatting, charts, 
totals, tables and sparkline layouts to instantly summarize large volumes of data (see screen 
below). When using Quick Analysis to scrutinize text-only data, text specific options for 
highlighting duplicate or unique text items appear. 
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Queries 
 
Excel 2010, 2007 & 2003 include pre-designed “queries” that can import commonly used data 
such as stock quotes for updating a stock portfolio. All you need is a connection to the internet 
and of course, some stock ticker symbols. In Excel 2010 or 2007 select Data, Existing 
Connections, MSN MoneyCentral Stock Quotes (or in Excel 2003 select Data, Import External 
Data, Import Data Existing Connections, MSN MoneyCentral Stock Quotes) and then walk 
through the web query wizard for importing stock quotes. In just a few seconds, Excel will retrieve 
Real-Time data for NYSE, NASDAQ & AMEX, and 20 minute delayed stock prices from other 
exchanges (during the hours when the stock market is open) and display a grid of complete up-
to-date stock price information that is synchronized to the stock market’s changing stock prices. 
With each click of the “Refresh” button, the stock price information in Excel is updated - this sure 
beats picking numbers out of the newspaper.  
 

 
 
Completing the Stock Portfolio – Next link the grid data to another worksheet, and insert new 
columns containing the number of shares owned, as wells as an additional column to compute 
the total value based on shares owned, as shown below. 
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Refreshing the Stock Prices - Once you have created your portfolio, simply click the Refresh Data 
button on the “External Data” Toolbar in Excel 2003 or on the “Data Ribbon” in Excel 2010 & 
2007 shown below to update the current value of your Portfolio. 
 

 
 
Query Parameters - There are numerous options to help you extract exactly the data you want 
the way you want it. The “Web Query Parameters Box”, “Web Query Options box” and “External 
Data Properties Box” provide numerous options for controlling your web query. 
 
Excel 2013 Stock Quote Queries 
 
In Excel 2013, for unknown reasons Microsoft has removed the stock quote query option, 
therefore below are instructions for restoring this option.  
 

1. Launch Notepad (Start, Programs, Windows Accessories, Notepad) 
 

2. Enter the following information exactly: 
 

 
 

Web 
1 
http://moneycentral.msn.com/investor/external/excel/quotes.asp?SYMBOL=["QUOTE","Ent
er stock, fund or other MSN MoneyCentral Investor symbols separated by commas."] 

 
 

Or if you prefer, use this to query Yahoo’s stock prices:  
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3. Save the file using any name you want, but be sure to include the extension .igy as 
pictured. 

 

 
 

4. Make sure to save this file to the folder labeled My Data Sources. 
 

 
 

5. Now in Excel, from the Data tab select Existing Queries, then scroll to and launch the new 
query you just created – it should work just like it did in Excel 2010, 2007 and 2003. 
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Database Queries  
 
Microsoft Excel can also query and retrieve data you want from an external data source. For 
example, you can retrieve Microsoft Excel data about a specific product by region. You can create 
a simple query by using the Query Wizard, or you can create a more complex query by using the 
advanced features of Microsoft Query. 
 
To use Microsoft Query to retrieve external data, you must: 
 

1. Have access to an external data source - If the data is not on your local computer, you 
may need to see the administrator of the external database for a password, user 
permission, or other information about how to connect to the database. 
 

2. Install Microsoft Query - If Microsoft Query is not available, you might need to install it. 
 

3. Specify a source to retrieve data from, and then start using Microsoft Query -   For 
example, if you want to insert database information, display the Database toolbar, click 
Insert Database, click Get Data, and then click MS Query.  

 
For example, suppose we have some data in our accounting system – Sage MAS 200 ERP that we 
would like to analyze in Excel.  We can use the Database Query Wizard to build a query that will 
extract the data we need and place it in an Excel spreadsheet, as follows. 
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The first step is to select the type of database you want to query and to select the specific 
database. 
 

 
 
Upon the selection of the desired database a list of tables will be presented. Choose the desired 
tables, and select the desired data fields to be imported. You will then have the option to filter 
and sort the data before it is imported.  Finally you will be given the option to save the query so 
you can run it at a later date without having to start from scratch. Excel will then return a table 
full of the data you requested as shown in the screen below. 
  

http://www.carltoncollins.com/


Office 2013 for CPAs 

www.CarltonCollins.com Page 75 Copyright August 2013 
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Sparklines 
 

Sparklines – Sparklines are small cell-sized charts that you can embed in a worksheet next to 
data to get a quick visual representation of the data. For example, if you had a worksheet that 
tracked the performance of several dozen stocks, you could create a Sparkline for each stock 
that graphed its performance over time, in a very compact way. Here are examples: 

 
 

Gantt Charts 
 
Let’s start by tricking Excel into creating a Gantt Chart. Of course Excel does not do Gantt charts, 
so we will apply clever tricks to achieve the desired affects. It’s really not that hard and it works 
just as well in Excel 2013, 2010, 2007 and 2003. Start by preparing a simple list of tasks including 
start dates, duration of each task, and end dates (formulas in Excel can calculate the end dates). 
An example is shown below: 
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1. Start by creating a stacked bar chart  
2. Remove the Data Series by right mouse clicking and choosing Select Data Source 
3. Add a new Data Source Named Starting Date, and point to the range of start dates for the values 
4. Add another new data source named Duration (Days), and point to the range of duration days 

for the values 
5. Add Category Axis Labels and point to the Task names in Column A 
6. Remove legend by selecting legend and pressing the Delete key 
7. Click on the beginning series and set the Fill and Borders to None 
8. Right mouse click on the task labels, choose format Axis, and check the Categories in Reverse 

Order box (if needed) 
9. In two blank cells, write a formula referencing the start and end dates, convert these dates to 

numbers with formatting 
10. Use the resulting numbers to set the scale of the Gantt Chart (perhaps use a slightly larger range 

of dates) 
11. Right mouse click on the date range, set the minimum and maximums to fixed using the 

numbers acquired in the above step 
12. Format the date range to show a short date 
13. Format the remaining data bars to display a 3-D bevel 
14. For added touch, search Google images for a nice picture of a house, save it to your hard drive. 
15. Set the background plot area to picture, and wash out the picture enough so that the chart is 

still readable. 
16. Add a title or text boxes as needed to complete the description of the Gantt Chart 

The resulting Gantt chart is shown below. At this point, changing any of the start dates or 
duration dates will automatically update the Gantt chart. 
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Combination Charts 
 
A combination chart is used to show one chart on top of another 
chart, using the same scale by percentage. This allows the reader to 
better study the data to determine whether relationships, if any, 
exist between the two sets of data. For example, consider the simple 
study hours and resulting grade information shown to the right for a 
new college student – we will call him Austin. We have compiled a 
worksheet showing the number of hours in which Austin studied 
each week, and the average scores he achieved on his homework, 
quizzes, test and exams.  
 

1. Start by creating a line chart from your entire data range 
2. Rescale the top line by right clicking and change the series 

option to use a secondary axis 
3. Note the ranges on each side of the chart 
4. Next right mouse click one of the lines and choose Change 

Series Chart type, and choose a column chart format 
5. Now apply a chart format and study your date for any useful 

relationships 

 
 

 
 
As we can see by the resulting combination chart, approximately 26 hours of study are required 
each week in order to achieve an average grade of 90 or above, and approximately 20 to 22 hours 
of study are required each week to achieve a B average above 80. In our next case study we might 
want to analyze whether the amount of money his parents send to him each week affects the 
number of hours of study he puts forth each week.  
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Organization Charts 
 
Next we will create an organizational chart using the SmartArt capabilities in Excel 2013, 2010, 
and 2007. Excel 2003 offers a similar tool, but it is not as pretty. Start by choosing SmartArt and 
point to the desired chart format.  
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What’s New in Microsoft Office 2010? 
 

1. Office Button Is Replaced With File Tab – Excel 2007 included the Office Start button, 
which was not intuitive to anybody, despite what Microsoft said.  In Excel 2010, Microsoft 
Office axed the office Start button in favor of the File tab. YIPPY! 

 
1. Backstage View – The file tab provides new look and feel called “Backstage View”. This 

new view represents one of the biggest differences you’ll notice in Microsoft Excel 2010. 
Backstage View is displayed by clicking on Excel’s File tab, as in all the other applications 
that comprise Office 2010. The backstage view in is available in the other Office 2010 
applications, and each application uses a different color scheme to differentiate it from 
the others. In Excel 2010, the color scheme is green. 
  
In general, Backstage View provides basically the same commands found under the File 
menu in previous version of Excel such as Save, Save As, Open, Close, Print, etc. What’s 
new is the preview screen and info tabs that accompanying some of these selections. For 
example, when you select the print option, a preview of the print job is automatically 
displayed, as shown below. 
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The Print option Backstage View also provides access to various Page and Print settings, 
such as Duplexing, Orientation, Margins, and Scaling. The save and Send option also has 
a new look and feel, providing buttons for emailing, publishing, and saving files, as well as 
options to create PDF or XPS documents.  
 

 
The New option also incorporates a new look and feel with thumbnail previews of 
templates, and links to downloading more templates from the Web. 
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If you want to return to the old Excel 2007 look and feel when you click the File tab (not 
that you would want to), you can change registry settings, as detailed in this article on 
Turning Off The Microsoft Office 2010 OutSpace located here: 
 

http://www.off14.com/microsoft-office-2010-outspace/ 
 
(They’ve actually got the name wrong in this article; although the registry key is named 
“outspace”, the display is called Backstage View.)  
 

2. Double Clicking Fill Handle Uses Connected Columns For Fill Down – In previous versions of 
Excel, the double click only worked if data were located in the column immediately to the left 
or right of the range to be copied, but Excel 2010 will use more distant columns provided they 
are connected with a common set of column labels.  
 

3. Custom Lists Obey Character Case Example – When using the Smart List feature, Excel 2010 
obeys the case (proper, lower, and upper) that is used in your starting phrase.  

 
4. Remove Hyperlinks (Instead Of One Hyperlink at A Time In 2007 And 2003) – In earlier 

versions of Excel, you could only remove one hyperlink at a time (the work around is to copy 
and paste a range containing hyperlinks and paste them as text elsewhere, then copy and 
paste that result back to your original location. Excel 2010 can remove all hyperlinks from a 
range in just one step. 

5. Sparklines – Sparklines are small cell-sized charts that you can embed in a worksheet next to 
data to get a quick visual representation of the data. For example, if you had a worksheet that 
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tracked the performance of several dozen stocks, you could create a Sparkline for each stock 
that graphed its performance over time, in a very compact way. Here are examples: 

 
 

6. Conditional Formatting Improvements – Microsoft has improved and added more styles and 
icons regarding the ability to apply a format to a range of cells, and then have the formatting 
change according to the value of the cell or formula.  

 
a. Solid Bars - Data Bars can be solid now in Excel 2010. Excel 2007 bars offered only a 

gradient effect, which was visually was confusing to read. Below is a comparison on the 
Excel 2007 and Excel 2010 Data Bar options.  

 

  
 

b. Negative Numbers - Microsoft also corrected a problem which Excel 2007 had creating 
when Data Bars based on negative numbers by adding axis support for both positive and 
negative values. The screens shots below show Excel 2010’s new solution, and how Excel 
2007 got confused when applying Data Bars to the exact same data. 

 

   2007 Gradient           2010 Gradient       2010 Solid 
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c. More Data Bar Options - Notice that Microsoft added more Data Bar options as shown in the 
comparison below. 

 
 

 
 

d. More Icon Options - Notice that Microsoft added more Data Bar options as shown in the 
comparison below. 

              Excel 2010’s Data Bars               Excel 2007’s Data Bars 

           Excel 2010’s Data Bar Menu            Excel 2007’s Data Bar Menu 
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e. Arrow Colors - It is possible to change icons used for KIP i.e. You can have two arrows with 
different colors of if negative impact and positive growth are good for you. 

 
f. Referring to Data - You can now refer to data on different worksheets, and even refer to a range 

outside the Conditional Formatting area. The screen below shows the error message produced by 
Excel 2007 when you attempted to reference cells outside the Conditional Formatting area; Excel 
2010 now accommodates this situation. 

              Excel 2010’s Icon Menu         Excel 2007’s Icon Menu 
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7. Microsoft Excel Web App’s Improved Sharing – Excel 2010 has new and improved tools for 
sharing data with other people, including multiple people working on the same document at 
the same time. Excel Web App extends your Excel experience to the web browser, where you 
can work with workbooks directly on the site where the workbook is stored. Excel Web App 
is part of Microsoft Office Web Apps, and is available in Windows Live SkyDrive and in 
organizations that have configured Office Web Apps on SharePoint 2010. With Excel Web 
App, you can: 

a. View - View a workbook in the browser - When you click on a workbook to open 
it in Excel Web App, the workbook is displayed in view mode.  

b. Sort and Filter - You can sort and filter data in the workbook, expand PivotTables 
to see relationships and trends in the data, recalculate values, and view different 
worksheets. 

c. Browser-Based Editing - Edit a workbook in the browser - With Excel Web App, all 
you need to access your workbooks is a browser.  

d. Share - Your teammates can work with you, regardless of which version of Excel 
they have.  

e. Looks the Same - Your workbooks look the same in the browser as they do in Excel.  
f. Excel Tools - You can edit your worksheets in the browser, using the familiar look 

and feel of Excel. When you edit in the browser, you can change data, enter or 
edit formulas, and apply basic formatting within the spreadsheet.  

g. Simultaneous Access - You can also work with others on the same workbook at 
the same time. 

 
Microsoft offers a free solution called Windows Live SkyDrive, which enables everyone in your 
group to share Word and Excel (and other) documents. This solution also provides users with 
Word, Excel and PowerPoint applications (with limited functionality) so your group members 
can work in the same applications.  
 

Excel 2007 
Error 

Message 
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To use SkyDrive, sign up for a free Windows Live account at http://explore.live.com/. Under 
the SkyDrive menu, select Get started and follow the instructions for setting up a Windows 
Live account. Once you have completed the registration process, sign into your Windows Live 
Sky Drive account and click the Office menu option at the top of the screen to view your 
SkyDrive as follows: 
 

 
 
Next create a folder and upload (or create) the group’s Word and Excel files. Select the folder 
and click the Share menu option as shown to edit permissions and to send links to your group 
members, which will enable them to access the data files.  

 
When sharing files in this manner, to better protect your data, check the checkbox labeled 
Require recipients to sign in with Windows Live ID. This action will require your group 
members to obtain their own Windows Live accounts and use their passwords in order to 
access the data files. Otherwise, anyone who receives the link will be able to access the data 
files.  
 
Notes: The free version of Windows Live Sky Drive is limited to 25 GBs of storage, and 
individual files are limited to 50 MBs. For a fee, you can increase these capacities. Installing 
Microsoft’s free Silverlight browser add-in will enable drag and drop functionality to and from 
your SkyDrive. The Windows Live SkyDrive solution was first introduced in August 2007, and 
is widely used.  
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8. Customize the Ribbon Toolbar - The Ribbon tool bar has been enhanced, and is now highly 

customizable. For example, you can add your own tabs to the Ribbon (as shown below), you 
can add your own groups to each tab (also shown below), and you can add any commands or 
macros to your customized tabs and groups.  

 
 

9. Compatibility of .xlsx - In Excel 2007, Microsoft introduced a new XML format (.xlsx) which was not 
compatible with former .xls spreadsheet formats. This problem has been resolved - Excel files created 
in Excel 2010 may easily be opened in versions of Excel prior to Excel 2007. Now Excel 2010 will save 
files just as safe as the former Excel 2007, and the spreadsheet size is 75% smaller than the old .XLS 
version. 

 

 
 
10. Protected Mode - Excel 2010 includes a Protected View, so you can see the document and make a 

more informed decision before exposing your computer to possible vulnerabilities. By default, 
documents that originate from an Internet source are opened in Protected View. When this happens, 
you see a warning on the Message bar, along with the option to enable editing. You can control which 
originating sources trigger Protected View. You can also set specific file types to open in Protected 
View regardless of where they originate. Excel will not allow you to edit the documents unless 
document editing is enabled. To do this, click the Enable Editing option in order to enable document 
editing as shown in the following screen shot. 
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11. Trusted Documents - The trusted documents feature is designed to make it easier to open 
workbooks and other documents that contain active content, such as data connections or macros. 
Now, after you confirm that active content in a workbook is safe to enable, you don’t have to 
repeat yourself. Excel 2010 remembers the workbooks you trust so that you can avoid being 
prompted each time you open the workbook. 
 

12. Slicer - The Slicer feature provides new slice and dice capabilities within PivotTables – this helps 
you dynamically segment and filter the data. This feature is located on the Insert Tab. 

 

 
 

13. Macro - Macros in Excel 2010 now support working with shapes, including creating, moving or 
editing shapes. For example, you could now record a macro that automatically insert s the 
following SmartArt object. 

 
14. Enhanced Chart Diagram - In Excel 2010 double clicking a chart element automatically opens 

the chart’s format dialog box. 
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15. 64-bit version of Excel 2010 - Excel 2010 is now available in a 64-bit version, which means 
that it can take full advantage of your computer’s 64-bit motherboard and access more 
than 4 GBs of RAM. The result is even faster performance. 
 

16. Microsoft SQL Server PowerPivot for Excel - Excel 2010 now includes an add-in tool called 
Microsoft SQL Server PowerPivot which is a Business Intelligence tool that enables you to query 
multiple SQL Server databases across multiple corporate systems and web data on a real-time 
basis to produce PivotTables that can be shared via SharePoint. You can try this online at the 
following Virtual Labs web site:  
 

https://cmg.vlabcenter.com/prepare.aspx?moduleid=ad3bd3e9-8d2b-498d-94fa-
e41e1b09730d&ticks=633992819904236083. 

 

Microsoft now offers Project Gemini add-on for Excel 2010 that can handle very large 
amounts of data -- even worksheets that include hundreds of millions of rows. It will ship 
as part of SQL Server 2008 R2 in the first half of 2010; a community technology preview 
will be available in the second half of 2009. 

 

17. What-If with Write-Back - PivotTable What-If Analysis is the ability to modify values in 
PivotTable cells, recalculate the PivotTable with those values and, if the results are 
satisfactory, publish the changes so that they are reflected in the OLAP data source for 
other people to see. This feature is also called write back, though it really goes beyond 
just the ability to write values back to the cube. “What if our sales for New York increased 
by 10%?” “What if the total number of product orders fell by 25%?” These are examples 
of questions that PivotTable What-If Analysis is aimed at helping the user answer. Let’s 
take a look at the following scenario: 

 
Stephen, the sales manager at a small IT company, is trying to figure out what his optimal 
sales quotas should look like for 2010. Based on a previous analysis and forecasts for next 
year it seems like 2010 will have a large decrease in sales which would mean his quotas 
would be reduced by 10% from the 2009 quotas. With the new PivotTable What-If 
Analysis feature he can now modify the relevant values in his PivotTable report and 
calculate the PivotTable with the changes to see what the totals would look like without 
actually modifying the data source. (click to see larger image) 
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So here is what his PivotTable looks like after calculating with the changes: 

 
If he wants to keep these numbers and share them with other people he can go ahead 
and publish the changes to the OLAP data source. 

 
He can also just keep the changes locally without publishing back to the OLAP data source 
by simply saving the file. When the workbook is loaded again in Excel 2010 all the changes 
will be reapplied and the PivotTable recalculated. With little knowledge of OLAP data 
sources the manager was able to change values and recalculate his PivotTables. The 
changes can be shared across the organization by simply sharing the workbook or 
publishing the changes back to the OLAP data source. 
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Advanced Options - Advanced options for PivotTable What-If Analysis include being able 
to change the allocation method, which is the methodology in which the OLAP data 
source will allocate the newly entered values in the cube. Excel 2010 also gives you the 
ability to define your own weight allocation definitions from within an MDX editor.  
 

18. Recover Earlier Versions Of A File In Office 2010 - It is now easier to recover a Microsoft 
Word 2010, Microsoft Excel 2010, or Microsoft PowerPoint 2010 file if you close your file 
without saving, or you want to review or return to an earlier version of the file you're 
already working in.  

 

As with earlier versions of Office, enabling AutoRecover in Word 2010, Excel 2010 or 
PowerPoint 2010 will save versions while you are working in your file at the interval you 
select. Now, you can choose to keep the last autosaved version of a file in case you 
accidentally close that file without saving, so that you can restore it the next time that 
you open the file. Also, while you are working in your file, you can access a listing of the 
autosaved files from the Microsoft Office Backstage view. 

  

Note: You must have the “Save AutoRecover information” and “Keep the last autosaved 
version if I close without saving” enabled for these features to work. (The Recover 
Unsaved Workbooks option is available from the File tab, under the Recent menu option.  
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19. Named Sets - Named Sets have been added to Microsoft Excel 2010, allows you to create your 

own named sets. Simply locate the Fields, Items, & Sets button under the Ribbon, and it will allow 
you to define your own Named Sets. 

 
20. Excel Mobile 2010 for Windows Phone 7 - If you have Windows Phone 7, you can use 

Microsoft Office Mobile 2010 to work with your files from anywhere—whether you’re at 
work, at home, or on the go. Excel Mobile 2010 is part of Office Mobile and already on 
your phone in the Office Hub, so you don't need to download or install anything else to 
get started. 

 

You can use Excel Mobile to view and edit workbooks stored on your phone, sent to you 
as email attachments, or hosted on a SharePoint 2010 site through SharePoint Workspace 
Mobile 2010. When you edit a workbook via SharePoint Workspace Mobile, you can save 
your changes back to the SharePoint site when you’re online. You can create, update, and 
instantly recalculate your spreadsheets using many of the same tools you already know 
and use in the desktop version of Excel: 

a) Use the outline view to switch between worksheets or charts in a workbook. 
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b) Sort, filter, and manage your spreadsheets.  
c) Add or edit text and numbers. 
d) Add comments. 

21. Improved PivotTables 

PivotTables are now easier to use and more responsive. Key improvements include: 

a) Performance - In Excel 2010, multi-threading helps speed up data retrieval, sorting, 
and filtering in PivotTables. 

b) PivotTable Labels - It's now possible to fill down labels in a PivotTable. You can also 
repeat labels in PivotTables to display item captions of nested fields in all rows and 
columns. Watch a video about repeating item labels. 

c) Enhanced Filtering - You can use slicers to quickly filter data in a PivotTable with the 
click of a button and see which filters are applied without having to open additional 
menus. In addition, the filter interface includes a handy search box that can help you 
to find what you need among potentially thousands (or even millions) of items in your 
PivotTables. 

d) Write-back Support - In Excel 2010, you can change values in the OLAP PivotTable 
Values area and have them written back to the Analysis Services cube on the OLAP 
server. You can use the write-back feature in what-if mode and then roll back the 
changes when you no longer need them, or you can save the changes. You can use 
the write-back feature with any OLAP provider that supports the UPDATE CUBE 
statement. 

e) Show Values As feature - The Show Values As feature includes a number of new, 
automatic calculations, such as % of Parent Row Total, % of Parent Column Total, % 
of Parent Total, % Running Total, Rank Smallest to Largest, and Rank Largest to 
Smallest. Watch a video about changes to the Show Values As feature. Watch a 
video about changes to the Show Values As feature. 

f) PivotChart Improvements - It is now easier to interact with PivotChart reports. 
Specifically, it's easier to filter data directly in a PivotChart and to reorganize the 
layout of a PivotChart by adding and removing fields. Similarly, with a single click, you 
can hide all field buttons on the PivotChart report.  

 
22. Improved Solver Add-In - Excel 2010 includes a new version of the Solver add-in, which 

you can use to find optimal solutions in what-if analysis. Solver has an improved user 
interface, a new Evolutionary Solver, based on genetic algorithms, that handles models 
with any Excel functions, new global optimization options, better linear programming and 
nonlinear optimization methods, and new Linearity and Feasibility reports. In addition, 
the Solver add-in is now available in a 64-bit version. 
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Use Solver to determine the maximum or minimum value of one cell by changing other 
cells. For example, you can change the amount of your projected advertising budget and 
see the effect on your projected profit amount. 

 

Example of a Solver problem - In the following example, the level of advertising in each 
quarter affects the number of units sold, indirectly determining the amount of sales 
revenue, the associated expenses, and the profit. Solver can change the quarterly 
budgets for advertising (cells B11:E11), up to a total budget constraint of $40,000 (cell 
F11), until the value for the total profit reaches the maximum possible amount. The 
values in the decision variable cells are used to calculate the profit for each quarter, so 
the values are related to the formula in the target cell F15, =SUM(B15:E15). 

 

 

Decision variable cells 

Constraint cell 

Objective cell 

 

After Solver runs, the new values are as follows. 

 

 
For more solver examples, check out:  
http://www.solver.com/excel2010/solverhelp.htm  
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23. Improved Function Accuracy - Excel 2010 includes more accurate statistical and other 
functions. Certain existing functions have also been renamed to better describe what they 
do, as follows:  

a) Accuracy Improvements - A number of functions have been optimized to improve 
accuracy. For example, Excel 2010 returns more accurate results for the beta and chi-
squared distributions. 

 

b) More Consistent Functions - Certain statistical functions have been renamed so that 
they are more consistent with the function definitions of the scientific community and 
with other function names in Excel. The new function names also more accurately 
describe their functionality. Workbooks created in earlier versions of Excel will 
continue to work despite these name changes, because the original functions still exist 
in a Compatibility category. 

 

24. Improved Filter Capabilities - In addition to slicers, which are described earlier in this 
article, Excel 2010 comes with new features that make it easier to sort and filter data, as 
follows. 

 
a. New search filter - When you filter data in Excel tables, PivotTables, and 

PivotCharts, you can use a new search box, which helps you to find what you need 
in long lists. For example, to find a specific product in a catalog that stocks over 
100,000 items, start by typing your search term, and relevant items instantly 
appear in the list. You can narrow the results further by deselecting the items you 
don't want to see. 
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b. Filter And Sort Regardless Of Location - In an Excel table, table headers replace 
regular worksheet headers at the top of columns when you scroll down in a long 
table. AutoFilter buttons now remain visible along with table headers in your table 
columns, so you can sort and filter data quickly without having to scroll all the way 
back up to the top of the table.  

 

25. Performance Enhancements - Performance improvements in Excel 2010 can help you to 
interact with your data more efficiently. Specific investments include: 

 
a) General improvements - Excel 2010 is more responsive when you move and resize 

charts, work in Page Layout view, and interact with shapes on the worksheet.  

b) Support For Large Data Sets - Excel 2010 handles workbooks that contain massive 
amounts of data more efficiently. Specifically, it takes less time to perform activities 
commonly performed on large data sets, such as filtering and sorting the data, copy 
and pasting it from one worksheet to another, and using the Fill feature to copy 
formulas.  
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c) Multicore Improvements - Multithreading improvements in Excel 2010 help to speed 
up the process of retrieving, sorting, and filtering data in PivotTables and Excel tables. 
In addition, opening and saving large files is generally faster than before. 

d) Faster Calculation - To achieve faster calculation performance, Excel 2010 includes 
support for asynchronous user-defined functions, which can run simultaneously 
without using multiple Excel calculation threads.  

26. Improved Charting - It's now easier to work with charts in Excel 2010. Specific 
improvements include: 

 
a) New Charting Limits - In Excel 2010, the limitation on the number of data points that 

can be created on a chart has been removed. The number of data points is now limited 
only by available memory.  

b) Quick Access To Formatting Options - In Excel 2010, you can instantly access 
formatting options by double-clicking a chart element. 

c) Macro Recording For Chart Elements - In Office Excel 2007, recording a macro while 
formatting a chart or other object did not produce any macro code. In Excel 2010, 
however, you can use the macro recorder to record formatting changes to charts and 
other objects. 

27. Support for Equations - You can use the new equation editing tools in Excel 2010 to insert 
common mathematical equations into your worksheets or to build up your own equations 
by using a library of math symbols. You can also insert new equations inside of text boxes 
and other shapes. To get started, on the Insert tab, in the Symbols group, click the arrow 
next to Equation.  
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28. More Themes - In Excel 2010, there are more themes and styles than ever before. These 
elements can help you apply professional designs consistently across your workbooks and 
other Microsoft Office documents. Once you select a theme, Excel 2010 does the design 
work. Text, charts, graphics, tables, and drawing objects all change to reflect the theme 
you have selected, so that all elements in your workbook visually complement one 
another. 
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29. Paste With Live Preview - The paste with live preview feature enables you to save time 
when reusing content within Excel 2010 or across other programs. You can use it to 
preview various paste options, such as Keep Source Column Widths, No Borders, or Keep 
Source Formatting. The live preview enables you to visually determine how your pasted 
content will look before you actually paste it in the worksheet. When you move your 
pointer over Paste Options to preview results, you'll see a menu containing items that 
change contextually to best fit the content you are reusing. ScreenTips provide additional 
information to help you make the right decision. 

 

30. Improved Picture-Editing Tools - If you use photos, drawings, or SmartArt to 
communicate visually, you can take advantage of the following features:  

 
a) Screenshots - Quickly take a screenshot and add it to your workbook, and then use 

the tools on the Picture Tools tab to edit and improve the screenshot. 

 

b) New SmartArt Graphic Layouts - With new picture layouts, you can tell your story 
with photographs. For example, use the Captioned Picture layout to show pictures 
with nice-looking captions underneath.  
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c) Picture Corrections - Fine tune the color of a picture, or adjust its brightness, contrast, 
or sharpness—all without having to use additional photo-editing software.  

d) New and Improved Artistic Effects - Apply different artistic effects to your picture to 
make it look more like a sketch, drawing, or painting. New artistic effects include 
Pencil Sketch, Line Drawing, Watercolor Sponge, Mosaic Bubbles, Glass, Pastels 
Smooth, Plastic Wrap, Photocopy, Paint Strokes, and many more.  

e) Better Compression And Cropping - You now have better control of the image quality 
and compression tradeoffs, so that you can make the right choice for the medium 
(print, screen, e-mail) that your workbook will be used for. Read more about cropping 
and picture compression. 

31. Accessibility Checker - The new Accessibility Checker tool in Excel 2010 enables you to 
find and fix issues that can make it difficult for people with disabilities to read or interact 
with your workbook. You can open the Accessibility Checker by clicking the File tab, 
clicking Check for Issues, and then clicking Check Accessibility. Errors and warnings will 
appear in a task pane. You can then review the issues and see which ones you need to fix. 
In addition to the Accessibility Checker, you can add alternative text to more objects in 
your worksheet, including Excel tables and PivotTables. This information is useful to 
people with visual impairments who may be unable to easily or fully see the object. 

 
32. Improved Language Tools - In the Excel Options dialog box, multilingual users can quickly 

set preferences for editing, display, ScreenTip, and Help languages. And, changing your 
language settings in Excel automatically changes them across all applicable Microsoft 
Office 2010 applications. If you don't have the software or keyboard layout installed that 
you need, you are notified, and links are provided to make it easier to quickly resolve such 
issues. 
 

33. Improved Programmability Features - Improvements for developers include:  
 

a) Changes to the XLL SDK - The XLL Software Development Kit (SDK) now supports 
calling new worksheet functions, developing asynchronous user-defined functions, 
developing cluster-safe user-defined functions that can be offloaded to a compute 
cluster, and building 64-bit XLL add-ins. 

b) VBA Improvements - Excel 2010 has a number of features that will enable you to 
migrate any remaining Excel 4.0 macros you may have to VBA. Improvements include 
better performance for print-related methods and chart properties not previously 
accessible with VBA. 

c) Better User-Interface Extensibility - If you develop custom workbook solutions, you 
have more options for programmatically customizing both the ribbon and the new 
Backstage view. For example, you can programmatically activate tabs on the ribbon, 
and make custom tabs behave similarly to built-in contextual tabs, where tabs only 
appear when specific events occur. In addition, you can make custom ribbon groups 
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grow and shrink as the ribbon is resized and customize context menus with rich 
controls. You can also add custom UI and other elements to the Backstage view. 

d) Changes to the Open XML SDK - The Open XML SDK 2.0 now supports schema-level 
objects, in addition to the part-level support introduced in the Open XML SDK 1.0. This 
makes it easier to programmatically manipulate workbooks and other documents 
outside the Office 2010 desktop applications—for example, as part of a server-based 
solution. 

34. Sixty One New Functions in Excel 2010 

 

In Excel 2010, Microsoft added 61 new functions and improved 19 others. This page contains a 
summary of those new functions and improvements. CPAs will notice that many of these 
functions are more scientific in nature, or are geared more towards engineers and statisticians. 
However, there are a handful of new functions that apply to the CPA function - particularly when 
it comes to data analysis. I've place a  next to those new functions which I consider more useful 
in standard CPA applications.  
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 Microsoft Office Tips 
 
 Tech Q & A Article Title Subject 
 That’s A Shifty Move Windows - Internet Explorer Trick  
 I Hope to See You Zoom Excel - Zoom 
 Heaven Help Us  Windows - GodMode 
 Would You Like to Share A Date?  Outlook - Shared Calendars 
 It’s Time to Split Excel's Split Tool 
 Help, I Can’t Click Back! Windows - Internet Explorer Trick  
 I Command You  Excel's Hidden Tools 
 Full Screen Ahead Windows - Internet Explorer Trick  
 I Report to Inform You… QuickBooks - Grouping Reports 
 Say Goodbye to Wimpy Searches Windows - Indexed Searching 
 The Search for a Better Search  Windows - Advanced Searching 
 Picture This FaceBook - Save a Picture 
 Dating Tips Excel – Date Entry 
 Count On It Windows Calculator 
 Hide Me Quick Excel – Custom Views 
 Caps Off to You Word – Caps Lock 
 Powerful Points for PowerPoint PowerPoint (5 Tips) 
 An Excellent Arrangement Excel – New Window 
 Pasting Away Again… Excel – Paste Trick 
 A Sticky Situation Windows Sticky Notes 
 Foot Your Financials in Excel Excel 
 An Iconic Solution Windows Icons 
 A Smart Solution to Formatting Bullet Lists Word 
 Internet Explorer 8 Shortcuts IE Shortcuts 
 Windows Shortcuts Windows Shortcuts 
 Add Value, Instantly Excel 
 A Colorful Preview Windows/Excel 
 Ergonomics Checklist Other 
 One Tall Solution Excel 

A Colorful Preview Windows/Excel 

Mastering Your CDs Windows 

Your Finest Port Outlook 

Outlook 2010 & 2007 Shortcuts Outlook 

Hiding between the pages Word 

Your type is not allowed Word 

Drive-by viruses Security 

Desperately Geeking Susan Other 

Conditional aftermath Excel 

IE 8 shortcuts IE Shortcuts 
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That’s A Shifty Move 
 

 Because I live in a rural area, slower access to the internet is my only option, but I still 
do a great deal of reading on the web. The slower speed makes it frustrating to click 
back and forth between the articles and the main page because I have to wait for the 

main page to reload each time. Is there a way to speed up my browser? 
 

Here is an easy solution for you. The next time you click a hyperlink on your main page 
to read a news story, hold down the Shift Key. This action will cause the news story to 
launch in a new browser window. When you are done reading the news story, simply 

close the browser window and the original browser window continuing the main page will 
remain intact. In the example below I’ve clicked the News Release hyperlink on the FASB web 
site while holding down the Shift Key. This action caused the linked article to launch in a 
separate browser window.  
 

 
 
Another measure you might consider is setting your page refresh setting to Never. This action 
will cause web pages that you visit to be cached on your computer hard drive, and the next 
time you access that same web page, it will launch immediately from your computer instead of 
slowly from the Internet. The downside of this approach is that you must remember to refresh 
the web page manually (by pressing the F5 Key) whenever you want to view the current version 
of that web page; otherwise, you might be reading an older version of the web page and not 
realize it.  

Q 

A 
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To adjust this setting in the Windows Explorer browser, choose Tools, Internet Options, and 
click the Settings button in the Browsing History section. Check the radio button labeled Never 
under the Check for newer versions of stored pages and click OK.    

 
I Hope to See You Zoom 
 

I use Excel 2003 and I sometimes find it difficult to read the small font in my worksheet. 
To make the worksheet more readable, I use the View, Zoom, 200% option, but I find it 
tedious to switch back and forth from 100% to 200% view. Is there a better approach 

that I am missing? 
 

In Microsoft Excel 2003, 2007 and 2010, you can zoom in and out instantly by holding 
down the Ctrl Key while rolling the wheel on your scrolling mouse. This approach is not 
only faster, but it also allows you to zoom up to a 400% view, down to a 10% view, and 

any option in between. This works in Microsoft Word too.  
 
Microsoft Office 2007 and 2010 now include a new Zoom tool at the bottom right hand corner 
of the screen which accomplishes the same result.  
 

 
 

Heaven Help Us  
 

I am new to Windows 7 and I really like the look and feel as well as the speed of this new 
operating system. However, I find myself apprehensive about learning to navigate 
another computer system. What can I do to learn the ropes as fast as possible? 

 
The features and functions of Windows 7 are similar to those in Windows XP; therefore, 
you are already familiar with these settings and tools. The trick is learning how to 
navigate Windows 7’s redesigned menus. Microsoft constantly studies the way users 

interact with their computers and strives to improve the system to make it easier to use, and 
that is a good thing.  Unfortunately, this  means  we must periodically relearn to navigate the 
new system and figure out where all of the Windows settings and controls reside.  If you are 
willing to take on an advanced step, this tip may help. Microsoft has embedded a shortcut to all 
of the features and functions in Windows 7 which they refer to as GodMode. This mode is used 
internally by many Microsoft programmers and staff to quickly manage their Windows settings 
and controls.  
 

Q 

A 

Q 
A 
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To set up GodMode in Windows 7, create a new folder on your desktop by right mouse clicking 
on your desktop and selecting New, Folder. Next, change the name of the new folder by right 
clicking on the folder, and select Properties from the drop down menu. Under the General Tab 
select the Name of the Folder text box and type in the following code to change the name of 
the folder: 

GodMode.{ED7BA470-8E54-465E-825C-99712043E01C} 
 
The folder will change in appearance from the default blank folder icon to the GodMode icon 
shown in the upper left corner of the screen below. 
 

 

Thereafter, when you double click on the GodMode icon, a window will open containing a large 
collection of the popular controls, tools, features, and functions in Windows 7, including all 
Control Panel Tools, Administrative Tools, Gadgets, and much more.  Because this window will 
allow you to view all the Windows 7 settings and controls in a single location, this might help 
you transition to Windows 7 a little easier. An example of the GodMode window is shown 
below.  
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Would You Like to Share A Date?  

I work in a small CPA firm and my partners and I have busy schedules. We seem to waste 
a lot of time trying to coordinate our schedules which we all keep in Microsoft Outlook 
2007. Our computer consultant has suggested that we set up a Microsoft Exchange 

Server so we can share our calendar information, but this measure is expensive and seems 
complicated. Is there a different approach that is easier and costs less?  

While Exchange Server is a good solution which provides many advantages, Microsoft 
Outlook 2003, 2007, and 2010 provide an easy solution to this problem called Send a 
Calendar via E-Mail.  To use this feature, open Outlook 2007 and click on Calendars in 
the Outlook Navigation Pane. Select the option Send a Calendar via E-Mail as shown in 

the screen below. 

 

This action will launch the Send a Calendar via E-Mail dialog box shown below. Select the date 
range you would like to send and click OK. (In your situation you will probably want to select 
the Whole Calendar option.)  

Q 

A 
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Outlook will compile your calendar into a file using the iCalendar format and prepare it for 
sending to your recipient. The resulting e-mail will appear as follows. 

 

When the recipient receives and opens the e-mail containing the calendar information, a 
button labeled Open this Calendar will be displayed in the menu. Simply click the Open this 
Calendar button to display it side-by-side next to your calendar in Outlook or for a different 
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view, select the Overlay option from the Arrangement group on the View menu to display both 
calendars in Overlay mode as shown below.  

  

To complete the sharing process, have your partner share their calendar with you using this 
same procedure.  

Note: The specific steps for using this Send a Calendar via E-mail tool are slightly different in 
Outlook 2003 and 2010, but essentially the same concept is employed.  

It’s Time to Split 
 

I have a large Excel worksheet and I need to be able to compare data throughout the 
worksheet. I’ve been using the View, Freeze Panes tool to temporarily freeze rows or 
columns so that I can view and compare data in different parts of the worksheet, but 

this method requires a lot of freezing and unfreezing. Is there a better option? 
 

Excel 2003, 2007 and 2010 contain two Split Screen tools which allow you to quickly split 
the Excel worksheet horizontally, vertically, or both. Like the Freeze Pane tool, the split 
screen tools also allow you to view and compare different portions of your data. To use 

these tools, click and drag the split screen tools to the desired positions. The Split Screen tools 
are located in the upper right hand corner and lower right hand corner of the worksheet area, 
as shown below. 

Q 

A 
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In the example below the Vertical Split Screen tool has been used to display data for the 1st 
quarters of 2009 and 2010. (Notice that the columns jump from column E to column O). 
Additionally, the Horizontal Split Screen tool has been used to fix the column headings at the 
top of the worksheet. (Notice that the row numbers jump from row 3 to row 7.)  

 

 

 
Help, I Can’t Click Back! 
 

Sometimes when I am browsing the internet, I notice that when I click on a hyperlink 
and then click the Back Button to return to the previous page, it doesn’t take me back. 
Am I doing something wrong? 

 
You are not doing anything wrong. This is a nasty trick some web developers play. 
What’s happening is some web pages load and then refresh automatically, so the effect 
is that the web page loads twice. Therefore when you press the Back Button, it actually 

works correctly, but it only takes you backward one page to the first instance of the same web 
page you are already viewing. You can often overcome this problem by double-clicking the 
Back Button to travel backward by two web pages quickly.  
 

Q 
A 
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(Tip: You must double-click quickly so the first page backward does not have time to refresh 
again.)  

 
I Command You 
 

Recently, I upgraded to Excel 2007 and I can’t seem to find all of the same commands I 
used in Excel 2003, such as the ability to e-mail a single worksheet or pivot multiple 
ranges of data. Why did Microsoft get rid of some of Excel 2003’s commands and are 

there any good work-around procedures for these missing capabilities? 
 

The missing functionality you mention is still there in Excel 2007 and 2010, but it is 
hidden. When Microsoft redesigned the menus for Excel 2007 and 2010, they excluded 
219 commands from the newer menu ribbon. To view a complete list of these hidden 

commands follow these steps: Start by right-mouse clicking on the Quick Access Toolbar and 
choosing the option to Customize Quick Access Toolbar.  
 

 
 
Next, in the Choose commands from drop down box, select the option to view Commands Not 
in the Ribbon.  
 

Q 

A 
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This action will display the list of 219 commands not included in the ribbon on the left side of 
the dialog box, and those commands that are included in your Quick Access Toolbar on the right 
side of the dialog box.  
 

 
 
To access these hidden commands, you must first add them to your Quick Access Toolbar by 
highlighting the desired command in the left column, and clicking the Add>> button to include 
it in the right column. Most of the hidden tools are obscure and seldom used, however some of 
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them are among my favorites. The seven Excel 2003 commands that are most notably missing 
from the Excel 2007 and 2010 menu ribbon are shown below. 
 

 
 
While the particular commands you choose to add to your Quick Access Toolbar will depend on 
personal preference, I recommend that you add the above mentioned commands to your Quick 
Access Toolbar, as well as the following twenty additional commands which I personally find 
more useful, to make them easily assessable. 
 

 
 
Note: There are a few Excel 2003 capabilities that have disappeared from Excel 2007 and 2010. 
For example: 
 

1. You can no longer publish web pages in an interactive format (The interactive format 
command in Excel 2003 allows you to publish HTML pages in which readers can input data 
directly via their browser).  
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2. Embedded video clips and sound clips no longer play as embedded objects in Excel 2007 and 

2010; instead those clips are played in your computer’s default media player application.  
 
3. There is no longer an auto format option which automatically highlights your subtotal rows.  

 

Full Screen Ahead 
 

 When browsing the internet I like to hide my browser’s menu and toolbars by right 
mouse clicking on the toolbar and unchecking the various menu and toolbar check 
boxes. This gives me more room to view the web page. However, it is a hassle to 

constantly remove and restore the toolbars like this. Is there a faster way to hide the browser’s 
toolbars? 
 

There is a better way. Simply select View, Full Screen from the browser’s menu, or as a 
shortcut press the F11 Key. Either way, this action will hide all toolbars and display the 
full screen on your monitor. To restore the browser toolbars, simply press the F11 Key 

again. 
 

 
 
Note: There is a catch. Windows Internet Explorer will only allow you to apply the Full Screen 
setting to one browser window at a time. In other words, if you choose Full Screen in one 
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browser window, you won’t be able to choose Full Screen in another browser window at the 
same time. 
 

I Report to Inform You… 

Our bookkeeper uses QuickBooks and she does a nice job; however I can’t get her to 
produce and distribute the necessary reports each day, week and month for our staff to 
use in order to properly manage our business. She says that she has too much work to 

constantly print the reports that I would like to see circulated throughout the organization on a 
recurring basis. Is this a common problem and how much time should it normally take to 
produce the typical reports for the average company? 

First of all, congratulations on understanding the importance of the reporting process; 
your accounting system should function exactly as you described. However your 
bookkeeper is correct too, it does take a great deal of time to produce all of the required 

reports, even for a smaller sized business. QuickBooks provides a good solution called Process 
Multiple Reports which could solve your problem. Here’s how it works: 

1. Start by opening your Memorized Report List in QuickBooks by selecting Reports, 
Memorized Reports, Memorized Report List from the QuickBooks Menu. Next click the 
Memorized Report button in the bottom left corner of the Memorized Report List (shown 
below) and select New Group. Name the new group Month End Reports and then select 
OK. 

 

2. Next, open each report that you would like to produce at month end and memorize that 
report into the new Month End Reports Group as follows:  
 

Q 
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a. Launch a report  that you want produced each month;  
 

b. Customize that report to include the desired columns, date ranges, filters, etc.; 
 

c. Click the Memorize button and if asked, then click the New button;  
 

 

 

d. Edit the Name of the report to also include the name of the intended recipient of 
the report as circled in the screen below. Check the check box titled Save in 
Memorized Report Group and select Month End Reports from the drop down 
box, then select OK.  

 

e. Repeat the above process until you have memorized each report to be produced 
at month end, including duplicates of the same report for distribution to different 
personnel. Be sure to include the name of the intended recipient in the report title 
name so it will be easier for a staff person to distribute the printed reports. 
Ultimately the goal is to build a group of memorized reports similar to the example 
shown below: 
 

http://www.carltoncollins.com/


Office 2013 for CPAs 

www.CarltonCollins.com Page 117 Copyright August 2013 

 

 

 

Tip: You can rearrange the order of the reports by clicking and dragging the small 
diamonds to the left of each report name so the reports will print in collated 
order for easier distribution.  

 

f. At month end when the time comes to produce the reports, select Reports, 
Process Multiple Reports from the QuickBooks Menu to display the Process 
Multiple Reports dialog box shown below. 
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Select the desired group to be printed from the Select Memorized Reports From 
drop down box at the top of the dialog box, and click the Print button.  

Tip: For those that would like to distribute electronic reports rather than paper-
based reports, you can choose to print to Adobe Acrobat PDF or Excel formats, and 
then e-mail the reports as attachments. 

 

Say Goodbye to Wimpy Searches 
 

I find myself frequently wasting time by launching and closing data files in an effort to 
find the one I am looking for. My friend has suggested that I re-organize my files in 
various folders instead of the single data folder I use now, but that is going to take a lot 

of work. Is this a good approach or is there a better approach to finding the files I am looking 
for? 
 

Organizing your files in various file folders used to be the right approach, but that 
measure is now less necessary because Windows Vista and Windows 7 both provide a 
tool called Instant Search which can search all of your files in just a few seconds. Instant 

Search uses “indexed searching”, which is the same search method used by internet search 
engines such as Google and Bing. Specifically, Instant Search scans and indexes all of the 
documents and files on your computer and builds a giant index of every word. Thereafter, when 
you search your computer, the system searches the index to quickly locate the files you seek 
and provides hyperlinks to those files.  
 
Indexed searching is significantly faster than the search tool included in Windows XP. (If you 
have ever wondered why it takes only two seconds to search billions of pages on the internet, 
but 10 minutes or longer to search the files on your Windows XP computer, indexed searching 
is the reason.) 

Q 
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To use Instant Search open an Explorer Window by right mouse clicking on the Windows Start 
Button and choosing Explore in Windows Vista, or Open Windows Explorer in Windows 7. 
Browse to the desired drive or folder, and enter your search terms in the Search Box located at 
the top right hand of the screen. Within seconds, Instant Search will list every file and folder 
that contains your search terms in the file or folder name, file contents, or properties. For 
example, in the screen below I have browsed to my data folder and typed in the phrase 
“regression” in the search box . In about two seconds Instant Search displays 2,231 data files 
that contain the phrase “regression”. (If I don’t find the exact file I want immediately, I can use 
additional search tools to narrow my results. Keep reading below to learn about these 
additional search capabilities.) 
 

 

 
 
Note: By default, Windows Vista and Windows 7’s Instant Search tool only indexes and searches 
those files in your Documents Folder. If you save data files elsewhere on your computer, you 
can direct Instant Search to also index those additional drives or folders by selecting Indexing 
Options from the Control Panel and then click Modify, Show All Locations, and place a check 
mark next to drives or folders that you want included in your search index. 
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For Windows XP Users - If you are still using the Windows XP operating system, but you would 
like to perform the same type of fast indexed searching that Windows Vista and Windows 7 
provide, you can download and install the Google Desktop for free at this web address: 
http://desktop.google.com/en/?ignua=1. By default, Google Desktop will index all of the files 
on your computer. 
 
Note 1: Both Instant Search and Google Desktop can also index and search your e-mails for fast 
searching.  
 
Note 2: You can adjust the settings to direct both Instant Search and Google Desktop to include 
other computers and files servers in the indexed search. 
 
Note 3: Both Instant Search and Google Desktop will take time to index all of your files, perhaps 
overnight. Thereafter, new files that you create are indexed automatically as they are created. 

 

The Search for a Better Search  
 

Our CPA firm has more than 400,000 data files on the file server and we constantly 
struggle to locate the right file. For example, recently an audit staff retrieved an Excel 
file which contained fixed assets and depreciation calculations and used this in the audit. 

Unfortunately the version of the file retrieved was not the most current and as a result, 
additional time was wasted updating the older file. We hope to avoid problems like this in the 
future. What is the best way to manage such a large volume of files? 
 

The previous question above addressed the concept of indexed searches, but let’s dig a 
little deeper into this subject. The Explorer Window provides additional searching 
capabilities to help you quickly view and narrow your search results. Continuing with the 

example from the previous question, I can further refine my search results by clicking on any 
column heading to view filter options. As an example, in the screen below I have clicked the 
Drop Down arrow next to the Type column heading. This action “stacks” the data files 
according to “type of file”. Notice that I have many file types containing the word “regression” 
including Excel 2003 and 2007, Word 2003 and 2007, HTML, PowerPoint, XML and others.  
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Selecting specific file types (Word 2003 and 2007 files in the example above) further narrows 
my search results. If I still need a more refined search, Windows Vista and Windows 7 offer 
Advanced Search. To access the Advanced Search tool click the Search Tools Drop Down Arrow 
in the Windows Explorer Title Bar, and select Search Pane as shown below. (Note: This option 
will only be visible in the Explorer Title Bar after you have started a search by typing a search 
term in the search box). 
 

 
 
Next in the Search Pane click the Advanced Search Arrow to display the Advanced Search 
Panel containing additional search options as shown below.  
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These advanced options will enable you to search by specific date ranges, file sizes, file names, 
author’s names, and tags.  
 
To fully utilize the advanced searching capability, it is helpful to add document properties to 
your data files. You can access the document properties in Microsoft Word as follows: 
 

Word 2010 - Select File, Properties, Show Document Panel; 
Word 2007 - Select Office Start Button, Prepare, Properties; and  
Word 2003 - Select File, Properties.  

 
The documents properties panel (example shown below) will allow you to insert keywords, 
authors, titles, and comments.  
 

  
The Document Properties you add will be used by the Instant Search function to not only 
locate files, but also to sort the resulting files in priority order according to those that most 
closely match your search criteria. This type of search could have helped your audit staff locate 
all of the client’s fixed asset depreciation files on your file server, enabling them to select the 
most current one from the list.  

Picture This 
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I recently spent some time looking through my daughter’s Facebook page with her and I 
saw several photographs posted by her friends that I would like to keep, or perhaps 
print for my own photo albums. Can this be done, and if so how? 

 
If you see a picture you like (on Facebook, Flickr, MySpace or any web page), you can 
save that picture to your computer by right clicking on the picture and selecting Save 
Picture As. Then browse to the folder where you want to save the photo and label it 

using an appropriate name so it will be easy to find in the future. That way you will always have 
those pictures to view, print or share.  
 

 
 
Note: While most social media web site users are probably happy to share their photos with 
you, you should avoid making copies of pictures posted by professional photographers. If there 
is any doubt, ask permission first.  

 

Dating Tips 
Q. When entering dates in Excel, it would be much simpler if I could enter the date as just the 
numbers without the forward slash character – 061010 or 06102010 instead of 06/10/10 or 
06/10/2010. Entering the slash makes the exercise a two-handed exercise instead of one-
handed exercise via the numeric keyboard. Is there a way to enter data into just one cell so I 
can avoid using multiple cells and then concatenating? 
 

A. You can enter dates into Excel 2003, 2007 and 2010 without using slash marks by applying a 
custom format. Start by highlighting the range of cells and right-mouse click on that range to 
display the pop-up menu. Select Format Cells to display the Format Cells dialog box. On the 
Number tab select Custom, and enter the following custom format in the Type box: 
00\/00\/0000, then click OK. (Because the forward slash has special meaning in a custom 
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format, you must precede it with a backslash for Excel to recognize the slash mark as a literal 
character, not its special meaning.) Thereafter, dates entered without slash marks will display 
slash marks, and the date will behave like a date instead of text. An example is shown below.  
 

 
Once created, Excel remembers the custom format so you won’t have to create it again in the 
future. 
 

 
 
Hint: To display dates without the preceding zeros, use this custom format. ##\/##\/##.  
 

Count On It 
Q. We import commodities from around the world and frequently need to convert weight and 
volume measurements from metric system to United States customary measurements (for 
example, liters to gallons and meters to feet). Last year we purchased Windows 7 computers 
and developed Excel templates to help meet this need, but we have recently discovered that 
some of the Excel templates contain errors and other templates are not being used correctly. I 
would like to drop our spreadsheet-based solution and use an easier tool to get the job done. 
Can you recommend a decent solution?  
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A. The Windows 7 Calculator includes new functionality, including unit conversion capabilities 
that could meet your needs. To use this tool, launch the Calculator by clicking the Start button, 
Accessories, Calculator.  In the Calculator, select Unit Conversion from the View menu as 
shown below.  
 

 
 
Next, select an option from the Select the type of unit you want to convert box which includes 
the following option: angle, Area, Energy, Length Power, Pressure, Temperature, Time Velocity, 
Volume and Weight/Mass. In the From box, enter an amount and select the appropriate unit of 
measure using the drop down arrow. In the To box, use the drop down arrow to select the 
target unit of measure and Calculator will display the converted unit of measure.  
 
Hint: The Windows 7 Calculator also has new functionality for calculating mortgages, vehicle 
leases, and dates in addition to new programmer and statistic modes.  
 

Hide Me Quick 
Q. I am constantly hiding, un-hiding and re-hiding columns to generate reports in a multitude of 
report layouts, and I can’t figure out how to display only the hidden column that I need without 
having to display all my hidden columns? Can you help? 
 
A. Because hiding and un-hiding columns is a frequent task for many CPAs, I will address your 
specific question, and then offer a different solution. To unhide a specific column in Excel 2003, 
2007 or 2010, press the F5 key to launch the Go To dialog box and type in any cell address 
within that column (such as G1), and click OK. This will place your cursor within column G, even 
if hidden. Next, type the keyboard shortcut sequence Alt, O, C, U to unhide the column.  
 
Alternatives – There are many alternatives for un-hiding columns, several of which are 
presented below so you can use the approach that work’s best for you. 

1. Menu Options - To unhide a column using the menu in Excel 2007 and 2010, from the Home tab, 
select Format from the Cells group, Hide & Unhide, Unhide Columns. To unhide a column using 
the menu in Excel 2003, select Column, Unhide from the Format menu.   
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2. The Traditional Unhide Shortcut - In Excel 2003, 2007 and 2010, Windows XP users can unhide a 
column by typing Ctrl + Shift +), but this keystroke combination appears to be inactive in Windows 
Vista and Windows 7.  

3. Column Width - Instead of un-hiding a column, you could simply increase the column width to 
make it visible. Start by pressing the F5 key to open the Go To dialog box and enter a cell address 
to go to a hidden column. To resize column widths in Excel 2007 and 2010, from the Home tab, 
select Format from the Cells group, Column Width, enter the desired width, and click OK. To 
resize a column width in Excel 2003, from the Format menu select Column, Width, enter the 
desired width, and click OK.  

 
Advanced Hint: To make your task easier, assign a name to a cell in each column you wish to 
hide or unhide using the Name Box (located just above the Column A heading). For example, 
you might assign the name YTD to cell G1, and the name Budget to cell H1. This will make it 
easier for you to use the Go To command because the name makes it obvious which column is 
which, whereas you might have a difficult time remembering which column label is which. 
Further, you could also use the Name Box to assign a name to a group of columns, and use the 
same procedure described above to hide or unhide that group. For example, you might assign 
the name PriorYear to cells J1 thru M1, and use the Go To command to go to those columns 
and unhide the entire lot.  
 
A Better Suggestion - Rather than constantly hiding and un-hiding columns, a better approach 
would be to use the Custom Views feature in Excel 2003, 2007 and 2010. By creating custom 
views, you can easily toggle back and forth between all of your views. To create your first 
custom view, unhide all of your columns and from the View tab (or View menu in Excel 2003), 
select Custom Views. Click the Add button and enter a description in the Name box, then click 
OK. Next, hide various columns in your workbook and repeat these steps to create a second 
view of your data that includes selected hidden columns. Continue to create additional custom 
views for each of your desired hidden column layouts. Thereafter, you can reduce or eliminate 
the need to hide and unhide columns in the future by simply changing the view. To toggle 
between custom views, from the View tab by select Custom Views in the Workbook Views 
group, and double click the desired custom view as shown below. 
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Caps Off to You 
Q. Caps really bug me. It seems that I never know when I have the caps lock turned on. I think it 
changes by itself! Is there an app for Windows which easily alerts (by sound would be nice) that 
the caps lock is on? Is there an EASY WAY TO CONVERT (whoops, didn’t know it was on) from 
caps to lower case in word, and also when I am in “reply” mode to an e mail without HAVING 
TO RETYPE? 
 
A. Most keyboards provide a light that lets you know when Caps Lock is turned on; if yours does 
not, you might consider upgrading your keyboard. To hear a sound when Caps Lock is turned on 
in Windows XP, Windows Vista or Windows 7, launch the Toggle Keys dialog box by holding 
down your NUMLOCK button for five seconds, and click Yes. Thereafter, a loud beep will sound 
through your computer’s speakers whenever Caps Lock is turned on or off. (To turn Toggle Keys 
off, once again hold down your NUMLOCK button for five seconds.) 
 

 
 
If you do accidentally use the wrong case when typing, you can change the case by highlighting 
the affected words and pressing Shift + F3 to toggle between proper, upper, and lower case 
characters. This works on single words, sentences, paragraphs and even across multiple pages. 
As for the spooky Caps Lock changing by itself, it is most likely that you are pressing the Caps 
Lock key by accident. Using Toggle Keys may help you isolate the cause of this problem. 
 

Powerful Points for PowerPoint  
Q. I have an interview scheduled for a new position that will require me to produce numerous 
presentations using PowerPoint 2010. I have used PowerPoint 2003 a little, but I need a crash 
course on some advanced functionality to help me better understand the product. Can you 
direct me towards five or so useful PowerPoint features that I can quickly study that will help 
me get up to speed on this product? 
 
A. Presented below are a handful of my favorite PowerPoint features that might help you 
elevate your PowerPoint knowledge to the next level.  
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1. Presenter View – The Presenter View allows you to view your slide show along with your speaker’s 
notes on your computer, while projecting only the slide show to the screen for the audience. The 
result is that you can see your detailed notes that accompany each slide, and the audience cannot.  
The Presenter View also displays the time spent on each slide and thumbnails located at the 
bottom of the Presenter View screen allow the speaker to see the previous and next slides, at a 
glance.  
 

 
 

To display a slide show using the Presenter View in PowerPoint 2007 and 2010, check the Use 
Presenter View checkbox on the Slide Show tab, and begin your slide show. In PowerPoint 
2003, select Slide Show, Setup Show, check the Show Presenter View checkbox, and begin your 
slide show. 
 

2. Animate Charts by Data Series – PowerPoint 2010 allows you to animate your charts by data 
series as follows. Start by creating a chart in PowerPoint, or if you prefer, copy and paste a chart 
from Excel into PowerPoint. Click on the chart to select it, and click Animation Pane from the 
Animations tab to display the Animation Pane. Again, with the chart still selected, from the 
Animation tab, click Add Animation and select an Entrance animation such as Bounce, for 
example.  
 
In the Animation Pane click the drop down arrow next to the animation and click Effect Options 
to open the Bounce dialog box. Next, on the Chart Animation tab, click the Group chart drop-
down arrow and select By Series, and click OK. Thereafter, when you display the slide show, 
each data bar series will bounce in individually, helping your audience identify the specific data 
series you are discussing. The screenshot below depicts the data series for sales representative 
Scott as the bars are bouncing into position. 
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Hints: The ability to animate charts by data series first appeared in PowerPoint 2007, 
and the instructions are similar, but not identical to those described above. This feature 
is not available in charts that contain links to other applications, such as Excel.   
 

3. Fill Charts with Employee Pictures or Customer Logos – PowerPoint 2003, 2007 and 2010 allow 
you to fill data bars and pie slices with pictures to produce a chart that is often easier to read. To 
fill a data series, right mouse click on a data bar series to select that series, and select Format 
Data Series from the popup menu. In the Format Data Series dialog box, select Fill, Picture or 
texture fill, and click the File button. Browse to the desired picture or image and click Insert. If 
desired, select the Stack radio button to stack multiple copies of the picture within the data bar. 
Repeat this process for each data bar.     

 

 
 

4. Narrate Your Slide Show – PowerPoint 2003, 2007 and 2010 allow you to narrate and record your 
slide show presentation. To narrate your slide show in PowerPoint 2010, make sure that you have 
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a microphone connected to your computer and from the Slide Show tab select Record Slide Show, 
and click the Start Recording button.   
 

 
 
To narrate your slide show in PowerPoint 2007, from the Slide Show tab, select Record 
Narration and click OK. In PowerPoint 2003, from the Slide Show menu, select Record 
Narration and click OK. 
 
Wearing a head set with a boom microphone will help capture your voice more consistently. 
Deliver your presentation as you normally would, using the mouse or space bar to advance your 
slides. To stop recording, simply close the Recording dialog box displayed in the upper left hand 
corner during the recording session, or press the ESC key. 
  

 
To stop recording a narration in PowerPoint 2003 and 2007, press the ESC key. If necessary, you 
can pause the recording by clicking the pause button in the Recording dialog box. The resulting 
file can be e-mailed, or uploaded to the Internet where others can view your complete 
presentation, including your voice, animations, and slide timing.    
 

5. Convert Your Slide Show into a Video Clip – A new feature available only in PowerPoint 2010 is 
the ability to convert your PowerPoint presentation into a Windows Media Video (WMV). The 
WMV file format is more transportable than a PowerPoint format, and can be easily uploaded to 
YouTube or streamed to handheld devices. The video will include your animations, narration, and 
timings. (If your slide show does not include timings, you can set the number of seconds each slide 
is to be displayed in the video in the Create a Video dialog box.) To generate a video file from your 
presentation, select Save & Send from the File tab and click Create a Video. From the untitled 
drop down option arrow, choose to create either a large, medium, or small video, click the Create 
Video button, enter a file name in the File name box, and click Save.  
 
(The large video option (960 X 720) provides the highest quality; the medium video option (640 
X 480) is best suited for creating DVDs, uploading to YouTube, or publishing to the Internet; and 
the small video option (320 X 240) is best suited for streaming to handheld devices.) 
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An Excellent Arrangement 

 
Q. Last year my office upgraded to two monitors at each workspace.  Having simultaneous full-
screen views of two different files is a vast improvement over split-screen windows.  Is it 
possible to display a different tab from the same Excel worksheet on two monitors? 
 
A. Start by displaying Excel across both monitors as follows: Click the Restore Down button in 
the upper right corner of the Excel window. Use the mouse to drag the edge of the Excel 
window across both monitors.  
 
To display two views of the same workbook in Excel 2007 or 2010, select New Window from 
the View menu, then select Arrange All, Tiled, OK also from the View menu. In Excel 2003, 
select New Window from the Window menu, then select Arrange, Tiled, OK also from the 
Window menu. You can view multiple worksheets from the same workbook side-by-side on a 
single monitor. In this situation, each window will scroll independently and best of all, according 
to reader Rick McNeil, updates entered into one window will automatically update the other 
windows. An example of multiple windows for the same workbook is shown below. 
 

 
 

Hint: To ignore other workbooks you have open, and arrange the windows for your current 
workbook only, check the Windows of active workbook checkbox in the Arrange Windows 
dialog box in Excel 2010, or the Arrange All dialog box in Excel 2007. 
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Pasting Away Again… 
Q. Often in Excel, I need to copy and paste the account number from one cell location to multiple cell 
locations. However, as soon as I use the Excel menu, the account number data from the source cell is 
deselected, and I must keep going back to recopy the original cell. Is there a trick to pasting contents to 
multiple cells without having to copy it repeatedly? 

 
A. This solution should help. Before you copy the contents of the source cell, click the F2 key to enter 
edit mode. Use your mouse to select the entire contents of the cell, then Right Mouse Click and select 
Copy from the popup menu (or press Ctrl + C). This action will copy the contents of your source cell to 
the Windows Clipboard where it will remain until you copy something else to clipboard. This will allow 
you to continue to paste the contents of the original cell multiple times without losing the source data, 
even if you use the Excel menu.       

 

 
 

A Sticky Situation 
Q. What’s a simple tool for keeping track of short notes and reminders? 
 
A. Windows Vista and Windows 7 offer a tool called Sticky Notes that is quick and easy to use. 
To launch Sticky Notes, click the Start button and type StikyNot.exe, and press Enter. This will 
display a small note like the one shown below. You can type a short message or if you have a 
mouse pen, you could write the message freehand. To create additional Sticky Notes, click the 
plus sign in the upper left corner of any existing Sticky Note. Use your mouse to drag and drop 
sticky notes to desired position. An example using Sticky Notes is shown below. 
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A stronger solution would be to use the Tasks feature in Outlook to track your reminders and 
to-do notes. Look for more on this topic in next month’s issue.  

 

Foot Your Financials in Excel 
Attaching Footnotes to Excel-based Financial Statements 
 
Q. We produce financial statements from Excel, but typing the footnotes at the bottom of the 
financial statements is a headache because Excel does not offer word wrap, outlining and other 
word processing features. We have tried using different solutions such as Excel’s Justify 
command, and pasting from Word, but these solutions fall short, especially when edits are 
needed. Is there a better approach? 
 
A. Embedding a Word document in Excel as an object is a solution that provides Word 
processing functionality in Excel. To embed a Word document in an Excel 2003, 2007 or 2010 
worksheet, select Object from the Insert tab or menu, then select Microsoft Word Document 
and click OK. Use the mouse to reposition and resize the resulting embedded Word Document 
Object underneath the financial statement (or in the appropriate position) as pictured below.   
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The embedded Word object allows you to type using the same word processing functionality 
provided by Word, such as outlining, paragraph justification, indenting, and Word shortcuts 
(such as Shift+F3 to change case). When you click away from the Word object, the Word menus 
disappear and the Excel menus return to normal. Double clicking on the Word object 
reactivates the embedded object allowing you to further edit its’ contents using word 
processing functionality. 

 
 
To finalize your footnotes, consider adding the following finishing touches: 
 

1. Font - For consistency, change the footnote font to match the font used in the financial 
statements.  
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2. Border - Click away from the Word box to deactivate the object, and click the Word box once to 
select it. Right-mouse click on the edge of the Word object to display the popup menu, and select 
Format Object as pictured above. On the Colors and Lines tab, click the Line Color drop down 
arrow and select No Line, and click OK.  

 
Once printed, the resulting footnotes will appear seamlessly at the bottom of the financial 
reports, as shown below. 
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An Iconic Solution 
Measures for Controlling the Display Order of Desktop Icons  
 
Q. I have about 40 icons on my desktop (five years of tax preparation software, several CPA 
productivity tools, the office suite, practice management and just plain computer overhead 
tools like the Recycle Bin).  I have arranged these icons so I can find them easily, but Windows 
sometimes rearranges them in no apparent order, and I have to start over.  I’d like to avoid 
putting them into folders on the desktop because that just adds another mouse click.  Is there a 
way to lock my icons in place? 
 
A. Desktop icons may automatically rearrange when the video resolution changes during boot-
up and you have Auto Arrange turned on. To turn off Auto Arrange, right click on the Desktop 
and in the popup menu: 
 

Windows XP - Select Arrange Icons By, and if selected, click Auto Arrange to deselect it. 
Windows Vista – Select View, and if selected, click Auto Arrange to deselect it.  
Windows 7 - Select View, and if selected, click Auto arrange icons to deselect it. 

 
Known Issue - Even with Auto Arrange turned off, this is a known issue with some Windows XP 
systems, and reportedly, in some cases, this problem can be corrected as follows: 
 

1. Arrange your desktop icons according to preference.  
2. Right click on desktop, select Arrange Icons By, and uncheck Show Desktop Icons.  
3. Right click on desktop, select Arrange Icons By, and check Show Desktop Icons. 
4. Re-boot your computer. 

 
Numbered Icons – A better solution may be to rename and number each ICON to control the 
specific order in which icons are auto arranged. As a practical matter, I always rename my 
desktop icons anyway, in order to abbreviate the name and save space. Examples of my 
renamed and numbered desktop icons are pictured below.  
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Using this approach, my frequently used icons remain in position, even with Auto Arrange 
enabled. This tip may be particularly beneficial to Windows 7 users when organizing folder 
icons because that system no longer allows users to disable Auto Arrange in folders.  
 

A Smart Solution to Formatting Bullet Lists  
Using Excel’s SmartArt to Format Bullet Lists 

 
Q. I frequently create multi-level numbered lists in Word, and I want these lists to stand out, so 
I spend a lot of time individually formatting the various levels in my lists, but this is a tedious 
process. Is there any way to create a list style or easily apply formats to a list? 
 
A. Word 2007 and 2010’s SmartArt Vertical Box List may provide the formatting solution you 
are looking for. As an example, SmartArt options were used to transform the boring list below 
on the left to the more vibrant list on the right.  
 

 
Specific steps for inserting a Smart List and achieving this transformation are described below. 

 
1. In Word 2007 or 2010, highlight and copy your outline list.  
2. Select SmartArt from the Insert tab to open the Choose a SmartArt Graphic dialog box.  
3. On the left side of the dialog box, select Lists, and then select the Vertical Box List as shown below. 
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4. Click the Vertical Box List to select it, and to display the Type your text here dialog box. (If the 
dialog box does not display, right click on the Vertical Box List and select Show Text Pane from 
the popup menu.) 

5. Click in the Type your text here dialog box and press Ctrl + A to select the default outline shown, 
and press Ctrl + V to paste your new outline. Your results should appear as follows: 

 

 
 

6. Add finishing touches by clicking on the Vertical Box List to select it, and to display the SmartArt 
Tools menu at the top of the screen.  Under the SmartArt Tools, Design tab, select Change Colors 
and select a desirable color scheme, such as Colorful Range – Accent Colors 2 to 3.  
 

7. Again from the SmartArt Tools, Design tab, select the SmartArt Styles dropdown and select 
Sunset Scene. 
 

Note: SmartArt graphics are limited to a single page and therefore larger lists that span multiple 
pages will need to be broken up into separate SmartArt images, which may make this 
formatting approach less desireable. 
 

Internet Explorer 8 Shortcuts 
 

1. CTRL + Enter – When typing a web address into your browser’s address box, pressing Ctrl + Enter 
will automatically insert the www. and .com. For example, type “HP” into the address bar and 
press Ctrl + Enter to quickly navigate to the www.HP.com web site. 
 

2. Shift + Click on a Hyperlink – This keystroke combination makes the hyperlink launch in a new 
window.  
 

3. CTRL + Scroll Wheel - Rolling the wheel forward and backward while holding down the CTRL key 
zooms in and out of the web page.  

 

Windows Shortcuts 
 

1. Windows key + M - This keystroke combination will instantly minimize all open windows. 
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2. Windows key + L – This keystroke combination will instantly lock your computer. You will need to 
log back in using your Windows password to continue. (This works in Windows XP or higher.) 

 
3. ALT + Open Folder - Holding the Alt key when opening a folder will open the folder’s properties 

dialog box (This is slightly quicker than Right-clicking on a folder and selecting  Properties from 
the popup menu). 
 

4. Windows key & Pause/Break - This keystroke combination opens the system properties dialog 
box. (This is quicker than navigating through Control Panel). 

 
5. Shift + Delete - Holding the Shift key while pressing Delete on selected files or folders will delete 

them permanently without placing a copy in the Recycle Bin. 

 

Add Value, Instantly 
Opening two Workbooks in one Instance of Excel across Multiple Monitors 
 
Q. When I open Excel on my two separate monitors, Excel doesn’t allow me to use Paste 
Special, Value, Add; it only works when I have the two workbooks opened on the same 
monitor. What’s going on and how do I fix this? 
 
A. The issue is not that you are using two computer monitors, the issue is that you have two 
instances of Excel open at the same time, and Excel’s paste function behaves differently when 
pasting between two instances of Excel compared to pasting between two workbooks opened 
in the same instance of Excel.  
 
Last month’s topic titled “An Excellent Arrangement” provided instructions for displaying two 
views of a single Excel workbook side-by-side on a single monitor. Building on this foundation, 
presented below are similar steps for displaying two different Excel workbooks side-by-side in a 
single instance of Excel stretched acorss two monitors. This approach will enable you to both 
view and use Paste Special, Value, Add between two different workbooks displayed on 
separate monitors.  
 

1. Open only one instance of Excel. 
2. Restore down the Excel window by double-clicking the Title Bar located at the top of the 

window.  
3. Stretch the window across both monitors by hovering your mouse pointer over either the 

left or right edge of the window until your pointer becomes a double arrow, then click 
and drag the window across both monitors.  

4. Open two Excel workbooks. 
5. In Excel 2007 and 2010, select Arrange All from the View tab to display the two 

workbooks side-by-side, each appearing in a sepeate monitor. In Excel 2003, select 
Arrange from the Window menu, select Tiled, and click OK. 

 
You can now use Paste Special, Value, Add between the two Excel workbooks.  
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A Colorful Preview  
Make Print Preview Display Charts and Tables in Color 

 
Q. I developed a presentation consisting of numerous Excel charts and data tables on my 
desktop computer, and I plan to use Print Preview to deliver the presentation. In practice, on 
my desktop computer this approach works well; but when I transfer the presentation to my 
laptop, the presentation previews in black and white, not color. I can’t find a setting anywhere 
to make my laptop preview in color. Can you help?  
 
A. I applaud your ingenuity; using Print Preview can sometimes be a quick and easy method for 
organizing and displaying selected portions of your Excel worksheet to an audience. Excel’s 
Print Preview uses the system’s default printer as a basis for rendering the preview. If you 
change your computer’s default printer to a color printer, the previewed print job will display in 
color.  
 
To change your default printer setting, launch Control Panel from the Start button, and: 
 

1. In Windows 7, select Hardware and Sound, Devices and Printers, 
2. In Windows Vista, select Hardware and Sound, Printers, 
3. In Windows XP, select Printers and Faxes, 

 

Right click on a color printer, and select Set as default printer from the popup menu as pictured 
below. 

 
You can set up and use a color printer for Print Preview purposes, even if you do not have a 
color printer attached to your laptop computer. To add a color printer:  
 

1. Launch Control Panel and: 

 
a. In Windows 7 and Vista, select Hardware and Sound, Add a printer, 
b. In Windows XP, select Printers and Faxes, and under the Printer Tasks menu, 

select Add a printer, 
 

2. In the Add Printer dialog box, select Add a local printer,  
3. Choose any port from the Use an existing port drop down menu and click Next,  
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4. Select any manufacturer and color printer model and click Next,  
5. Provide an appropriate name in the Printer Name box, click Next,  
6. If asked to share the printer, select No, 
7. Click Finish. 

 
 

One Tall Solution 
Leave the Tall Print Setting Blank when Scaling to Width 
 
Q. When printing large worksheets in Excel 2003, is there an easy trick to figuring out how 
many pages tall the print job needs to be to ensure that my worksheet prints out as wide as 
possible on the page, but no wider? I usually set the page width to 1 page, then use the trial 
and error method to figure out how many pages tall the print job needs to be.  
 
A. Yes, there is an easy solution. Simply leave the tall box blank in Page Setup, and Excel will 
automatically calculate the number of pages tall the report needs to be to print your worksheet 
based on the number of pages wide you specify.  
 

 
 
Note: Excel 2007 and 2010 both provide the menu option Fit All Columns on One Page that 
accomplishes the same result.  
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A Colorful Preview  
Q. I developed a presentation consisting of numerous Excel charts and data tables on my 
desktop computer, and I plan to use Print Preview to deliver the presentation. In practice, on 
my desktop computer this approach works well; but when I transfer the presentation to my 
laptop, the presentation previews in black and white, not color. I can’t find a setting anywhere 
to make my laptop preview in color. Can you help?  
 
A. I applaud your ingenuity; using Print Preview can sometimes be a quick and easy method for 
organizing and displaying selected portions of your Excel worksheet to an audience. Excel’s 
Print Preview uses the system’s default printer as a basis for rendering the preview. If you 
change your computer’s default printer to a color printer, the previewed print job will display in 
color.  
 
To change your default printer setting, launch Control Panel from the Start button, and: 
 

4. In Windows 7, select Hardware and Sound, Devices and Printers, 
5. In Windows Vista, select Hardware and Sound, Printers, 
6. In Windows XP, select Printers and Faxes, 

 
Right click on a color printer, and select Set as default printer from the popup menu as pictured 
below. 
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You can set up and use a color printer for Print Preview purposes, even if you do not have a 
color printer attached to your computer. To add a color printer:  
 

8. Launch Control Panel and: 
a. In Windows 7 and Vista, select Hardware and Sound, Add a printer, 
b. In Windows XP, select Printers and Faxes, and under the Printer Tasks menu, 

select Add a printer, 
9. In the Add Printer dialog box, select Add a local printer,  
10. Choose any port from the Use an existing port drop down menu and click Next,  
11. Select any manufacturer and color printer model and click Next,  
12. Provide an appropriate name in the Printer Name box, click Next,  
13. If asked to share the printer, select No, 
14. Click Finish. 

 

Mastering Your CDs 
Q. My client created a backup of their data files using a CD disc, but when we tested the disc on 
another computer, we were unable to read the disc. Is there a secret trick to creating CDs that 
can be read by other computers? 
 
A. Burning CDs in Windows can be a confusing proposition. Windows provides the ability to 
burn discs using one of two available formats: Live File System and Mastered. Assuming your 
computer has a writable CD drive, to burn a disc using either format in Windows 7, Vista or XP, 
insert a writeable disc (CD-R, CD-RW, DVD or Blue-ray) into your computer's disc drive, and 
close the drive. The AutoPlay dialog box will appear offering several options, depending upon 
your computer and the software installed. (If the AutoPlay dialog box does not open 
automatically, follow the instructions for launching your disc burning program, these 
instructions will vary depending upon the computer and software you have). Select Burn files 
to disc using Windows to display the Burn a Disc dialog box. Click the Show formatting options 
dropdown arrow and check either the Live File System the Mastered radio buttons as shown.  
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Click Next to display an empty disc folder, then drag the files you want to write to the CD to the 
empty disc folder and click the Burn to disc button located at the top of the folder. In the dialog 
box that follows, click Burn files to data disc.  
 
Each format has advantages and disadvantages as follows: 
 
Mastered CDs - The Mastered format is the superior format for compatibility with other 
computers because it creates discs with special formatting and extra coding that is compatible 
with most Windows based computers and many other operating systems. The disadvantage is 
that to create a Mastered CD, you must collect the files you want copied and burn them in bulk, 
instead of adding files to the CD one (or a few) at a time.   
 
Live File System – The Live File System format allows you to create a reusable CD that behaves 
like a USB thumb drive, allowing you to add files from the CD as needed, and without having to 
burn the entire CD. The disadvantage of the Live File System format is that it is less compatible 
than the Mastered format, and compatibility varies based on the version of Live File System. A 
summary of the four versions of Live File System and their compatibility follows: 

1. Live File System version 1.02 – Compatible with Windows 98 and many Apple 
computers.  

2. Live File System version 1.5 – Compatible with Windows 2000, Windows XP, and 
Windows Server 2003. (It is usually with Windows 98 and Apple computers depending 
upon various factors.) 

3. Live File System version 2.01 – Compatible with Windows XP and Windows Server. (It is 
usually compatible with Windows 98, Windows 2000, and Apple computers, depending 
upon various factors.) 

4. Live File System version 2.5 – Compatible with Windows 7 and Vista. (It is usually 
compatible with earlier versions of Windows, depending upon various factors.) 
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Therefore, Mastered CDs offer better compatibility while Live File System CDs offer better file 
convenience for adding and deleing files. Using the Mastered format to create backups will 
ensure greater compatibility for restoring your backup to another computer. 
 

Your Finest Port 
Q. I can receive e-mail through Outlook, but I can no longer send e-mail through Outlook. My e-
mail used to work just fine and I have not changed the password or any mail settings. What’s 
going on and how do I fix this problem? 
 
A. It sounds like your internet service provider (or a relay service provider) has tagged you as a 
spammer and is therefore blocking your outgoing e-mail. This is a common problem, 
particularly for those who send messages using e-mail merge (because groups of merged e-mail 
messages appear similar to spam activity).You may also have been tagged as a spammer if your 
computer is infected with a virus that is secretly sending spam from your computer when idle. 
(This may be possible even if you are running anti-virus software.)  
 
Although this problem sounds bad, you can usually solve it by changing your outgoing port from 
25 to 587, as follows: 

Outlook 2010 – From the File tab, select Info, Account Settings, Account Settings 
(again) to open the Account Settings dialog box. Under the E-mail tab, select the E-mail 
account that is not sending properly and click Change to open the Internet E-mail 
Settings dialog box. Click the More Settings button, and on the Advanced tab change 
the value in the Outgoing server (SMTP) box to 587 as shown, and click OK, Next, 
Finish. Click the Close button to close the Account Settings dialog box.   
 

 
 
Outlook 2007 – From the File menu, select Data File Management to open the Account 
Settings dialog box. Under the E-mail tab, select the E-mail account that is not sending 
properly and click Change to open the Internet E-mail Settings dialog box. Click the 
More Settings button, and on the Advanced tab change the value in the Outgoing 
server (SMTP) box to 587, and click OK, Next, Finish. Click the Close button to close the 
Account Settings dialog box.   
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Outlook 2003 – From the Tools menu, select E-mail Accounts, and in the resulting 
dialog box select View or change existing e-mail accounts and click Next. Click the More 
Settings button, and on the Advanced tab change the value in the Outgoing server 
(SMTP) box to 587, and click OK.   
 

This issue relates to the Internet Engineering Task Force (IETF) memorandum RFC 4409 
Message Submission for Mail, a set of standards formalized in April 2006 to help fight spam. 
Among other measures, this memorandum mandates that for all e-mail messages sent via port 
587, any alias names must be resolved as e-mail is relayed from one server to the next, making 
it easier to trace the true source of e-mail messages. Messages sent via port 25 are not required 
to abide by such standards, therefore many internet service providers now block messages sent 
via port 25 for any sender suspected of spam. Upon changing your port setting, you should be 
able to once again send e-mail. 
 

Outlook 2010 and 2007 Shortcuts 
1. Convert an E-Mail to a Task – Selecting an e-mail message and pressing the Insert key converts 

the e-mail to a task and copies the task to your Tasks list. In addition, the Outlook message is 
flagged in red to let you know that it is linked to a task.  
 

 
 

2. Convert an E-Mail to an Calendar Appointment – First, make sure that the To-Do Bar is visible 
by selecting To-Do Bar, Normal from the View tab. Select an e-mail, then drag and drop it on a 
specific date on your calendar (in your To-Do Bar) to create an appointment on your calendar. 
Add the location, start time, and end time (if necessary), and click the Save and Close from the 
Appointment tab.  

 

 
 

3. Convert an E-Mail to a Meeting Request – Follow the same procedure described above for 
creating a calendar appointment, except before you Save and close, select Invite Attendees 
from the Appointment tab to create a meeting request. Select recipients to invite to the 
meeting using the To button, then click the Send button.  
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4. Convert an E-Mail Sender to a Contact – In an open e-mail, right click on the name of the sender 
to display the popup menu, and select Add to Outlook Contacts, and click Save and Close from 
the Contact tab. 

 
 

5. To Search All Mail Folders – In Outlook 2010, from the Search tab select Search Tools, Search 
Options, and click the radio button labeled All folders. In Outlook 2007, next to the Search box, 
click the down arrow and select Search All Mail Items.  
 

 

HIDING BETWEEN THE PAGES 
 
Q. Is it possible to temporarily hide or suppress headers, footers or page borders when reading 
a Word document? 
 
A. Double clicking on the separation between pages will suppress headers, footers, borders, 
space between the pages, and any extra white space at the bottom of a page, thus allowing you 
to view the maximum amount of text on your screen. For example, the two screens below show 
the same document, except the view on the right has been collapsed, allowing you to view 
three pages of text instead of just one.  
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To restore the headers, footers and space between the pages, double-click the solid line 
separating the pages. Keep reading below for another potential solution.  
 

YOUR TYPE IS NOT ALLOWED 
 
Q. I like to review Word documents in Full Screen Reading view, but when I catch typos or want 
to make changes, I must switch back to Print Layout view to make those changes. Is there a 
different option that allows me to read more text on the screen, yet edit the text at the same 
time?  
 
A. Word’s Full Screen Reading view quickly suppresses the menus and positions two sequential 
pages side by side, enabling you to view more text. By default, this view does not allow editing, 
but you can enable editing as follows. In Full Screen Reading view, click the View Options 
dropdown button in the top right corner, and select Allow Typing.   
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This action will allow you to make changes in Full Screen Reading view.  Also shown in the 
screen image above, additional options allow you to temporarily increase or decrease the text 
size for better readability, without actually changing the text size in the document. Further, 
related to the previous question, the Margin Settings option provides the ability to Suppress 
Margins, as shown below.   

 

 
 
(If the Suppress Margins option is greyed out, select the option Show Printed Page to make the 
Suppress Margins option available.)  
 

DRIVE-BY VIRUS 
 
Q. While one of my employees was surfing the internet, a browser un-expectantly popped up 
warning that his computer was infected with a virus. A few seconds later, the browser started 
scanning the computer’s hard drive and downloading files. Each time he closed the browser; 
another browser popped open and continued the process. Finally, he pulled the plug, but by 
then the damage was done and the computer would not reboot.  Ultimately, we hired a 
technician to reformat and reload the programs and data from scratch. The employee is certain 
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that the computer was running an anti-virus program at the time, but we could not confirm 
this, or determine which one. How do I prevent this problem from recurring?   

 
A. Even if you are running virus protection software, it is possible to encounter a virus like the 
one you described. The virus can be triggered by visiting an infected web page, clicking an 
infected hyperlink, or mousing over an infected web page object. While these viruses often 
warn of an infected computer and offer to scan your hard drive to solve the problem, in reality, 
the viruses usually use the opportunity to install more malicious code on your computer.  
 
Because new viruses continue to emerge, there is no sure way to absolutely protect your 
computer, but you can mitigate the problem. To protect your computer, always run up-to-date 
anti-virus software, avoid browsing suspicious or unknown web sites, and make frequent back-
ups of your computer systems. When I search the internet, the virus protection solution I use 
inserts an emblem at the end of each search result link verifying that the web site is virus free, 
and I often rely on this information before clicking the link. Hovering over the emblem provides 
a summary of this verification, and a link to a full report, as shown.  

 

 
 
In the event that I do click on a dubious web page link, my anti-virus software displays the 
following warning page, giving me one more chance to avoid the suspicious web page.   
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When Viruses Attack - If you do encounter a virus that continues to popup malicious browsers, 
you may be able to thwart the problem if you react quickly by pressing ALT + F4 repeatedly to 
close the current browser and subsequent browsers before they have a chance to fully popup.  
If you encounter a virus that freezes your computer, and the  mouse and keyboard stop 
responding, holding down the computer’s power button for 10 seconds will clear the 
computer’s memory cache and force a reboot.  
 
Warnings – These two actions may cause you to lose unsaved work. However, this may be a 
better option than allowing a virus to fully infect your computer. Also, be aware that holding 
down the power button down for 10 seconds will reboot your computer and offer you an 
option to restore your computer to its original factory condition. If you choose this option, you 
will lose your applications and data.  

 

DESPERATELY GEEKING SUSAN 
Q. It’s time for me to get a new computer, but I am not sure whether I should purchase a 
desktop, laptop, netbook, or perhaps even an tablet. Which solution do you think is best? – 
Susan 
  
A. Susan, you have asked a loaded question, which reminds me of the old adage “Ask ten 
consultants, get eleven answers.” There is no correct answer because it depends on many 
factors such as the type of work you do, the programs you run, the amount of travel, and 
personal preference. I think the best I can do is tell you what I use (and recommend) and hope 
this information is useful. I use four different types of computers, and each is valuable to me in 
its own way, as follows: 
 

1. Desktop Computer – I prefer a high-powered desktop computer with multiple monitors (mine 
has four) for getting most of my important work done. My workstation is well designed and 
highly functional, with a comfortable chair so I can be highly productive all day.  
 

2. Laptop Computer – I carry a laptop computer with me when I travel to stay connected to the 
office, get work done in a pinch, and to deliver technology presentations. Laptop computers are 
essential to my work. However, the truth is that I am not a big fan of laptop computers because 
they have smaller screens, smaller keyboards and I find them uncomfortable to use for extended 
periods. I usually either place the laptop in my lap which forces me to crane my neck down, or I 
place the laptop on a desk that is too high, which is uncomfortable for my arms.  Neither 
alternative is conducive to working 8 hours straight.  
 

3. Tablet – Desktop computers are most useful for crunching data such as heavy duty spreadsheet 
preparation, writing lengthy documents, preparing tax returns, managing an accounting system, 
etc. However, when it comes to accessing, viewing or reading information, a tablet device such 
as an iPad2 is most useful. My iPad2 is lightweight, turns on instantly, stores electronic versions 
of the books and magazines I am reading, organizes pictures and video clips, provides access to 
my e-mail, delivers the latest news stories, and connects to the internet.  
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4. Smart Phone – A smart phone is essentially both a cellular phone and a small hand held 
computer. In addition to keeping me connected via mobile phone, my smart phone contains 
dozens of applications such a turn-by-turn GPS directions, maps, weather updates, and travel 
expense management tools. I can also use my smartphone to take pictures, check and respond 
to e-mail, and access the internet.    
 

Ignoring software, my cost for these four devices is as follows:  
 

 Desktop (HP Pavilion with four monitors and web cam) - $1,400 

 Laptop (HP Pavilion) - $599 (refurbished price) 

 Tablet – (Apple iPad2) - $499 

 SmartPhone – (HTC Droid Incredible) - Free with $70 per month 2-year contract.  

 
Susan, while the functionality of these four types of devices overlap somewhat, I find that each 
device makes me more productive in its own way. If you do not travel or visit client offices, 
perhaps you could forgo the laptop computer; however, based on my experience, I would 
recommend all four of these devices to any tech-savvy CPA. 
 

THE AFTERMATH OF MANY CONDITIONS  
 
Q. I use COUNTIF and SUMIF to summarize detailed transactions based on criteria for one 
column, but I need to count and sum transaction data based on criteria for multiple columns. Is 
there an easy way to do this?   
 
A. Beginning with Excel 2007, Microsoft added the new functions SUMIFS and COUNTIFS, which 
are the plural equivalents to SUMIF and COUNTIF. These new functions each allow you to Sum 
or Count based on up to 127 criteria. The proper syntax for using these functions follows: 
 

SUMIFS(sum_range, criteria_range1, criteria1, criteria_range2, criteria2, …) 
COUNTIFS(count_range, criteria_range1, criteria1, criteria_range2, criteria2, …) 

 
For example, the worksheet below lists 100 rows of sales transactions, beginning at row 12. The 
highlighted formula in cell E6 calculates the total sales for all of Sales Rep Claire’s transactions 
that resulted in a profit margin of less than 15%.     
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Note: I could have inserted the criteria (“Claire” and “< 15%”) directly into the formula. Instead, 
I listed these criteria (along with other criteria) in a table format, and referenced the cells 
containing the criteria in the SUMIFS formula. This approach allows me to then copy the 
formula in cell E6 to the range E6…H9 (with slight edits to the formulas in columns F and G) to 
produce a summary table of values using the SUMIFS function.  
 
Advanced Tip: You can use the question mark (?) and asterisk (*) as wildcard characters in your 
criteria, whereas a question mark matches any single character, and an asterisk matches any 
sequence of characters. For example, to sum sales for those transactions resulting in less than 
15% profit, which also occurred in either the Northeast or Southeast, I used the criteria “*east”, 
as shown. 
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INTERNET EXPLORER 8 SHORTCUTS 
 

1. CTRL + Enter – When typing a web address into your browser’s address box, pressing 
Ctrl + Enter will automatically insert the “www.” and “.com”. For example, type “HP” 
into the address bar and press Ctrl + Enter to quickly navigate to the www.HP.com 
web site. 

2. Ctrl + T - Opens a new (blank) tab in the foreground. 
3. Ctrl + Click on a Hyperlink – This keystroke combination makes the hyperlink launch 

in a new tab in the background. 
4. Ctrl + Shift + Click on a Hyperlink – This keystroke combination makes the hyperlink 

launch in a new tab in the foreground.  
5. Ctrl+n (where n is a number between 1 and 8) - Switch to a specific tab number. 
6. Ctrl + Q - Toggle Quick Tabs (thumbnail view) on or off. 
7. CTRL + Scroll Wheel - Rolling the wheel forward and backward while holding down 

the CTRL key zooms in and out of the web page.  
8. Ctrl + Plus Sign – Increase zoom (+ 10%). 
9. Ctrl + Minus Sign – Decrease zoom (- 10%). 
10. Ctrl + 0 – Zoom to 10%. 
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Bio for J. Carlton Collins, CPA 
ASA Research   Carlton@ASAResearch.com   770.842.5902 

 

J. Carlton Collins, CPA is a Certified Public Accountant with experience in technology, 
tax, auditing, accounting systems, financial reporting, and bond financing. He is an 
author, lecturer, and technology & accounting systems consultant. He has published 
books, articles, and web pages and is the author of the monthly technology Q&A column 
for the Journal of Accountancy. As a public speaker, Mr. Collins has delivered more than 
2,000 lectures in 44 states and 5 countries addressing more than 500,000 CPAs and 
business professionals. As a consultant, Mr. Collins has assisted 275+ large and small 

companies with the selection and implementation of accounting systems. Mr. Collins has a Bachelor’s degree in 
Accounting from the University of Georgia, is a 25+ year member of the American Institute of CPAs and the Georgia 
Society of CPAs. 
  

Summary of Selected Positions, Awards & Accomplishments:  
  

1.   Honored as one of the CPA Industries Top 25 Thought Leaders by CPA Technology Advisor Magazine 

2.   Author of the monthly Technology Q&A column for the Journal of Accountancy. 
3.   Recipient of the AICPA’s Lifetime Technical Contribution to the CPA Profession Award.  
4.   Chairman of the Southeast Accounting Show - the South’s largest CPA event. 
5.   Recipient of the Tom Radcliff Outstanding Discussion Leader Award.  
6.   Named “Top Ten CPA Technologists” by Accounting Technologies Magazine (multiple years). 
7.   Named “Top 100 Most Influential CPAs ” by Accounting Technologies Magazine (multiple years). 
8.   Has personally delivered over 2,000 technology lectures around the world. 
9.   Recipient of the Outstanding Discussion Leader Award from the Georgia Society of CPAs.  
10. Lead author for PPC's Guide to Installing Microcomputer Accounting Systems.   
11. Has installed accounting systems for more than 200 companies. 
12. Chairperson of the AICPA Technology Conference.  
13. Recipient of the ACCPAC Partner of the Year Award. 
14. Determined by SAP to be one of the country's "Top Ten Most Influential ERP Systems Consultants". 
15. Has delivered keynote and session lectures at dozens of accounting software conferences. 
16. Sworn in as a Certified Public Accountant on September 18, 1985. 
17. Member of the American Institute of CPAs since 1985. 
18. Member of the Georgia Society of CPAs since 1982. 

  
 As an auditor, Mr. Collins has audited businesses in the areas of health care, construction, distribution, automobile 
dealerships, insurance, manufacturing, and general business.  Mr. Collins' tax experience includes corporate, 
individual, partnership, fiduciary, and estate tax planning work.  In the area of finance, Mr. Collins has prepared (or 
assisted in preparing) feasibility studies and financial forecasts for nearly 300 projects seeking more than $3 billion 
in startup capital. Mr. Collins is familiar with bond issues, Medicare and Medicaid reimbursement, and conventional 
financing matters. In 1992, Mr. Collins contributed and demonstrated more than 500 pages of suggested design 
improvements to the Microsoft Excel development team of programmers - and many of those improvements are 
found in Excel today. 
 
At the University of Georgia, Mr. Collins was elected President of the Phi Eta Sigma Honor Society, was initiated into 
the BIFTAD Honor Society, served three years in the Judicial Defender/Advocate program, and was a member of 
Alpha Tau Omega fraternity. At Glynn Academy High School, Mr. Collins was Senior Class President, Class 
Valedictorian (1 of 6), and received a principle nomination to Annapolis Naval Academy. Mr. Collins has been married 
for 27 years and has two children. He devotes his leisure time to family, travel, tennis, fishing, snow skiing, and riding 
motorcycles (both dirt and street). Mr. Collins is president of his homeowners association, participates in the 
Gwinnett Clean and Beautiful program, and volunteers for Cooperative Ministries food drive. 
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